
GIMT College, Budhlada | Fundamentals of Computer and IT 1 

 

Unit-I: Computer Fundamentals 
 
Short Answer Questions: 
Q. Write need of Hardware? (Nov 22) 
Ans. Hardware is essential for running software and performing input, output, and processing 
tasks in a computer. It includes all physical components like CPU, RAM, keyboard, etc. 
ਹਾਰਡਵੇਅਰ ਕੰਿਪਊਟਰ ਿਵੱਚ ਸਾਫਟਵੇਅਰ ਚਲਾਉਣ ਅਤ ੇਇਨਪਟੁ, ਆਉਟਪਟੁ ਤੇ ਪ�ੋਸੈਿਸੰਗ ਦੇ ਕੰਮ ਕਰਨ ਲਈ ਜਰੂਰੀ ਹੁੰ ਦਾ 

ਹ।ੈ ਇਸ ਿਵੱਚ CPU, RAM, ਕੀਬਰੋਡ ਆਿਦ ਸਾਰ ੇਭੌਿਤਕ ਿਹੱਸ ੇਸ਼ਾਮਲ ਹੁੰ ਦ ੇਹਨ। 

 
Q. Convert (135)10 into Binary (Nov 22) 
Ans. The decimal number 135 converts to binary as 10000111₂ using repeated division by 2 
method. 

ਦਸ਼ਮਲਵ ਸੰਿਖਆ 135 ਨੰੂ 2 ਨਾਲ ਵਾਰ-ਵਾਰ ਭਾਗ ਦੇ ਕ ੇਬਾਈਨਰੀ ਿਵੱਚ 10000111₂ ਵਜ� ਤਬਦੀਲ ਕੀਤਾ ਜ�ਦਾ ਹ।ੈ 

 
Q. Discuss use of Motherboard. (Nov 22) 
Ans. The motherboard connects all components of a computer including CPU, memory, and 
input/output devices. It serves as the central communication backbone. 
ਮਦਰਬੋਰਡ ਕੰਿਪਊਟਰ ਦੇ ਸਾਰ ੇ ਿਹੱਿਸਆ ਂ ਨੰੂ ਿਜਵ� ਿਕ CPU, ਮੈਮੋਰੀ, ਅਤ ੇਇਨਪਟੁ/ਆਉਟਪਟੁ ਿਡਵਾਈਸ� ਨੰੂ ਆਪਸ ਿਵੱਚ 

ਜੋੜਦਾ ਹ।ੈ ਇਹ ਕ�ਦਰੀ ਸੰਚਾਰ ਰੇੜ� ਦੀ ਹੱਡੀ ਵਜ� ਕੰਮ ਕਰਦਾ ਹ।ੈ 

 
Q. Compare inkjet printer with laser printer. (Nov 22) 
Ans. Inkjet printers use liquid ink and are cheaper but slower; laser printers use toner powder 
and are faster with better print quality for bulk tasks. 
ਇੰਕਜੈ{ਟ ਿਪ�ੰ ਟਰ ਤਰਲ ਸਾਈਹ ਦਾ ਉਪਯੋਗ ਕਰਦ ੇਹਨ ਅਤ ੇਸਸਤ ੇਹੁੰ ਦ ੇਹਨ ਪਰ ਹੌਲੀ ਕੰਮ ਕਰਦੇ ਹਨ; ਲੇਜ਼ਰ ਿਪ�ੰ ਟਰ ਟੋਨਰ 

ਪਾਊਡਰ ਵਰਤਦੇ ਹਨ ਅਤ ੇਤੇਜ਼ ਹੁੰ ਦ ੇਹਨ, ਬਹੁਤ ਸਾਰ ੇਿਪ�ੰ ਟ ਕੰਮ� ਲਈ ਵਧੀਆ ਗੁਣਵੱਤਾ ਿਦੰਦ ੇਹਨ। 

 
Q. What is the functioning of OMR? (Nov 22) 
Ans. Optical Mark Recognition (OMR) scans marked data from paper forms, commonly used in 
exams or surveys to read shaded bubbles. 
ਆਪਟੀਕਲ ਮਾਰਕ ਪਛਾਣ (OMR) ਕਾਗਜ਼ੀ ਫਾਰਮ� 'ਤੇ ਿਨ©ਾਨ ਲਗਾਈ ਗਈ ਜਾਣਕਾਰੀ ਨੰੂ ਸਕੈਨ ਕਰਦੀ ਹ,ੈ ਜੋ ਅਕਸਰ 

ਪਰੀਿਖਆਵ� ਜ� ਸਰਵੇਖਣ� ਿਵੱਚ ਛ�ਹ ਕੀਤੀਆ ਂਗੋਲੀਆ ਂਨੰੂ ਪੜ�ਨ ਲਈ ਵਰਤੀ ਜ�ਦੀ ਹ।ੈ 

 
Q. What is primary memory? (Nov 23) 
Ans.  Primary memory (RAM) is temporary storage used by the CPU to hold data and 
instructions currently in use for quick access. 
ਮੁੱ ਖ ਮੈਮੋਰੀ (RAM) ਇਕ ਅਸਥਾਈ ਸਟੋਰੇਜ ਹੁੰ ਦੀ ਹ ੈਜੋ CPU ਵੱਲ�  ਵਰਤ� ਿਵੱਚ ਆ ਰਹ ੇਡਟੇਾ ਅਤ ੇਹੁਕਮ� ਨੰੂ ਤੁਰੰਤ ਪਹੁੰ ਚ 

ਲਈ ਰੱਖਣ ਲਈ ਵਰਤੀ ਜ�ਦੀ ਹ।ੈ 

 
Q. Explain system bus. (Nov 23) 
Ans. A system bus is a communication path that transfers data among CPU, memory, and 
peripherals within the computer. 
ਿਸਸਟਮ ਬੱਸ ਇੱਕ ਸੰਚਾਰ ਮਾਰਗ ਹੁੰ ਦੀ ਹ ੈ ਜੋ ਕੰਿਪਊਟਰ ਦੇ ਅੰਦਰ CPU, ਮੈਮੋਰੀ ਅਤ ੇਪੈਰੀਫਰਲਸ ਿਵਚਕਾਰ ਡੇਟਾ ਦਾ 

ਆਦਾਨ-ਪ�ਦਾਨ ਕਰਦੀ ਹ।ੈ 

 
Q. Write the name of 5 components that we mostly see on a Motherboard. (Nov 23) 
Ans. Common motherboard components: CPU socket, RAM slots, chipset, BIOS chip, and power 
connectors.  
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ਆਮ ਮਦਰਬੋਰਡ ਿਹੱਸ:ੇ CPU ਸਾਕਟ, RAM ਸਲਾਟ, ਿਚਪਸ{ੈਟ, BIOS ਿਚਪ, ਅਤ ੇਪਾਵਰ ਕਨă ਕਟਰ। 

 
Q. What are the major functional units of a computer system? (Nov 24) 
Ans. Major functional units include Input Unit, Output Unit, Memory Unit, Control Unit, and 
Arithmetic Logic Unit (ALU). 
ਮੁੱ ਖ ਕਾਰਜਾਤਮਕ ਇਕਾਈਆ ਂ ਿਵੱਚ ਇਨਪਟੁ ਯੂਿਨਟ, ਆਉਟਪਟੁ ਯੂਿਨਟ, ਮੈਮੋਰੀ ਯੂਿਨਟ, ਕੰਟਰਲੋ ਯੂਿਨਟ ਅਤ ੇਅੰਕਗਿਣਤ 

ਤਰਕ ਯੂਿਨਟ (ALU) ਸ਼ਾਮਲ ਹਨ। 

 
Q. What is a number system, and why are they used in computer systems? (Nov 24) 
Ans. Number systems like binary, decimal, and hexadecimal are used in computers for data 
representation and processing at hardware level. 
ਬਾਈਨਰੀ, ਦਸ਼ਮਲਵ ਅਤ ੇਹੈਕਸਾਡੈਸੀਮਲ ਵਰਗੇ ਅੰਕ ਪ�ਣਾਲੀਆਂ ਕੰਿਪਊਟਰ� ਿਵੱਚ ਡਟੇਾ ਦੀ ਨੁਮਾਇੰਦਗੀ ਅਤ ੇਪ�ੋਸੈਿਸੰਗ ਲਈ 

ਹਾਰਡਵੇਅਰ ਪੱਧਰ 'ਤੇ ਵਰਤੀ ਜ�ਦੀਆ ਂਹਨ। 

 
Q. Define cache memory. (Nov 23) 
Ans. Cache memory is a high-speed memory located close to the CPU that stores frequently 
accessed data to reduce access time. 
ਕ©ੈ ਮੈਮੋਰੀ ਇੱਕ ਤੇਜ਼ ਗਤੀ ਵਾਲੀ ਮੈਮੋਰੀ ਹੁੰ ਦੀ ਹ ੈਜੋ CPU ਦੇ ਨĂ ੜੇ ਹ�ਦ ਿਵੱਚ ਹੁੰ ਦੀ ਹ ੈਅਤ ੇਵਾਰ-ਵਾਰ ਵਰਤ ੇਜ�ਦ ੇਡੇਟਾ ਨੰੂ 

ਸੰਭਾਲਦੀ ਹ ੈਤ� ਜੋ ਪਹੁੰ ਚ ਸਮ� ਨੰੂ ਘਟਾਇਆ ਜਾ ਸਕ।ੇ 

 
Long Answer Questions: 
 
Q. Discuss various types of Input and Output devices used in Computer Systems with their 
advantages. (Nov 22) 
Ans. Input and output (I/O) devices are essential components of a computer system that 
facilitate interaction between the user and the machine. Input devices allow users to feed data 
into the computer, while output devices display or transmit the results of processed data. 
Types of Input Devices: 

1. Keyboard – Used to enter text and commands. It is simple, reliable, and widely used. 
2. Mouse – A pointing device used for navigating the graphical user interface. 
3. Scanner – Converts physical documents into digital form. 
4. Microphone – Captures sound and converts it into digital signals. 
5. Webcam – Captures video and images for communication or recording. 

Advantages: Input devices increase the efficiency of data entry and enhance the usability of the 
computer for various applications like typing, drawing, and voice recognition. 
Types of Output Devices: 

1. Monitor – Displays text, graphics, and videos. Modern monitors include LCD and LED 
screens. 

2. Printer – Produces hard copies of digital documents. Types include inkjet, laser, and dot 
matrix printers. 

3. Speakers – Output audio signals. 
4. Projectors – Display large-scale visual content from the computer. 

Advantages: Output devices help users visualize results, generate physical records, and improve 
accessibility through audio and video output. 
Together, input and output devices bridge the communication gap between users and 
computers, making digital interaction seamless and effective. 
ਇਨਪਟੁ ਅਤ ੇਆਉਟਪਟੁ (I/O) ਿਡਵਾਈਸ� ਕੰਿਪਊਟਰ ਿਸਸਟਮ ਦੇ ਮਹੱਤਵਪੂਰਨ ਿਹੱਸ ੇਹਨ ਜੋ ਵਰਤ�ਕਾਰ ਅਤ ੇਮ©ੀਨ 

ਿਵਚਕਾਰ ਸੰਚਾਰ ਦੀ ਸਹਲੂਤ ਿਦੰਦ ੇਹਨ। ਇਨਪਟੁ ਿਡਵਾਈਸ� ਵਰਤ�ਕਾਰ� ਨੰੂ ਕੰਿਪਊਟਰ ਿਵੱਚ ਡੇਟਾ ਦਾਖਲ ਕਰਨ ਦੀ 



GIMT College, Budhlada | Fundamentals of Computer and IT 3 

 

ਆਿਗਆ ਿਦੰਦੀਆਂ ਹਨ, ਜਦਿਕ ਆਉਟਪਟੁ ਿਡਵਾਈਸ� ਪ�ੋਸੈਸ ਕੀਤੇ ਡੇਟਾ ਦੇ ਨਤੀਜੇ ਵੇਖਾ�ਦੀਆ ਂਜ� ਪ�ਸਾਿਰਤ ਕਰਦੀਆ ਂ

ਹਨ। 

ਇਨਪੁਟ ਿਡਵਾਈਸ� ਦ ੇਪ�ਕਾਰ: 

1. ਕੀਬੋਰਡ – ਿਲਖਤ ਅਤ ੇਹੁਕਮ ਦਾਖਲ ਕਰਨ ਲਈ ਵਰਿਤਆ ਜ�ਦਾ ਹ।ੈ ਇਹ ਸਧਾਰਣ, ਭਰੋਸਯੇੋਗ ਅਤ ੇਿਵਆਪਕ 

ਤੌਰ 'ਤੇ ਵਰਿਤਆ ਜ�ਦਾ ਹ।ੈ 

2. ਮਾਊਸ – ਇੱਕ ਪੌਇੰਿਟੰਗ ਿਡਵਾਈਸ ਜੋ ਗ�ਾਿਫਕਲ ਯੂਜ਼ਰ ਇੰਟਰਫੇਸ ਿਵੱਚ ਨĂ ਵੀਗਟੇ ਕਰਨ ਲਈ ਵਰਿਤਆ ਜ�ਦਾ ਹ।ੈ 

3. ਸਕੈਨਰ – ਭੌਿਤਕ ਦਸਤਾਵੇਜ਼� ਨੰੂ ਿਡਜੀਟਲ ਰੂਪ ਿਵੱਚ ਤਬਦੀਲ ਕਰਦਾ ਹ।ੈ 

4. ਮਾਈਕ�ੋਫਨੋ – ਧੁਨੀ ਨੰੂ ਕੈਪਚਰ ਕਰਕ ੇਿਡਜੀਟਲ ਿਸਗਨਲ� ਿਵੱਚ ਤਬਦੀਲ ਕਰਦਾ ਹ।ੈ 

5. ਵੈਬਕੈਮ – ਵੀਡੀਓ ਅਤ ੇ ਿਚੱਤਰ ਕੈਪਚਰ ਕਰਨ ਲਈ ਵਰਿਤਆ ਜ�ਦਾ ਹ,ੈ ਜੋ ਸੰਚਾਰ ਜ� ਿਰਕਾਰਿਡੰਗ ਲਈ ਵਰਤ ੋ

ਹੁੰ ਦ ੇਹਨ। 

ਲਾਭ: ਇਨਪਟੁ ਿਡਵਾਈਸ� ਡਟੇਾ ਦਾਖਲ ਦੀ ਪ�ਿਕਿਰਆ ਨੰੂ ਪ�ਭਾਵ©ਾਲੀ ਬਣਾ�ਦੀਆ ਂਹਨ ਅਤ ੇ ਕੰਿਪਊਟਰ ਦੀ ਵਰਤ� ਨੰੂ 

ਟਾਈਿਪੰਗ, ਡਰਾਇੰਗ ਅਤ ੇਵਾਇਸ ਿਰਕਗਨੀ©ਨ ਵਰਗੀਆ ਂਐਪਲੀਕ©ੇਨ� ਲਈ ਆਸਾਨ ਬਣਾ�ਦੀਆ ਂਹਨ। 

ਆਉਟਪਟੁ ਿਡਵਾਈਸ� ਦ ੇਪ�ਕਾਰ: 

1. ਮਾਨੀਟਰ – ਿਲਖਤ, ਿਚੱਤਰ ਅਤ ੇਵੀਡੀਓ ਿਦਖਾ�ਦਾ ਹ।ੈ ਆਧਿੁਨਕ ਮਾਨੀਟਰ� ਿਵੱਚ LCD ਅਤ ੇ LED ਸਕ�ੀਨ� 

©ਾਮਲ ਹਨ। 

2. ਪਿਰੰਟਰ – ਿਡਜੀਟਲ ਦਸਤਾਵੇਜ਼� ਦੀਆ ਂਹਾਰਡ ਕਾਪੀਆਂ ਿਤਆਰ ਕਰਦਾ ਹ।ੈ ਇਸ ਦੇ ਪ�ਕਾਰ ਹਨ ਇੰਕਜੈ{ਟ, ਲੇਜ਼ਰ 

ਅਤ ੇਡੌਟ ਮੈਿਟ�ਕਸ ਪਿਰੰਟਰ। 

3. ਸਪੀਕਰ – ਆਡੀਓ ਿਸਗਨਲ� ਨੰੂ ਆਉਟਪਟੁ ਕਰਦ ੇਹਨ। 

4. ਪਰੋਜਕੈਟਰ – ਕੰਿਪਊਟਰ ਤ� ਿਵਜ਼ੂਅਲ ਸਮੱਗਰੀ ਨੰੂ ਵੱਡੇ ਪੈਮਾਨĂ  'ਤੇ ਪ�ਦਰਿ©ਤ ਕਰਦਾ ਹ।ੈ 

ਲਾਭ: ਆਉਟਪਟੁ ਿਡਵਾਈਸ� ਵਰਤ�ਕਾਰ� ਨੰੂ ਨਤੀਜੇ ਵੇਖਣ, ਭੌਿਤਕ ਿਰਕਾਰਡ ਿਤਆਰ ਕਰਨ ਅਤ ੇਆਡੀਓ-ਵੀਡੀਓ ਆਉਟਪਟੁ 

ਰਾਹ� ਪਹੁੰ ਚ ਿਵੱਚ ਸੁਧਾਰ ਕਰਨ ਿਵੱਚ ਮਦਦ ਕਰਦੀਆਂ ਹਨ। 

ਨਤੀਜਾ: ਇਨਪਟੁ ਅਤ ੇਆਉਟਪਟੁ ਿਡਵਾਈਸ� ਵਰਤ�ਕਾਰ ਅਤ ੇਕੰਿਪਊਟਰ ਿਵਚਕਾਰ ਸੰਚਾਰ ਦੇ ਪੁਲ ਵਜ� ਕੰਮ ਕਰਦੀਆਂ ਹਨ, 

ਿਜਸ ਨਾਲ ਿਡਜੀਟਲ ਸੰਚਾਰ ਸੁਗਮ ਅਤ ੇਪ�ਭਾਵ©ਾਲੀ ਬਣਦਾ ਹ।ੈ 

 
Q.  a) What is the difference between primary and secondary memory? (Nov 23) 

b) What is the difference between a ROM and RAM? (Nov 23) 
Ans. a) Difference between Primary and Secondary Memory: Primary memory refers to the 
memory that is directly accessible by the CPU, such as RAM (Random Access Memory) and ROM 
(Read Only Memory). It is fast, volatile (except ROM), and is used to store data temporarily 
during processing. Secondary memory, on the other hand, is used for long-term data storage. It 
includes hard drives, SSDs, CDs, and USB drives. It is non-volatile, slower than primary memory, 
and holds data even when the computer is powered off. Primary memory is limited in capacity, 
whereas secondary memory offers larger storage space for permanent data retention. 
 
b) Difference between ROM and RAM: RAM (Random Access Memory) is a type of primary 
memory that is volatile and stores data temporarily while the computer is running. It is used for 
the system’s active processes and programs. When the system is turned off, data in RAM is lost. 
ROM (Read Only Memory), in contrast, is non-volatile and stores critical startup instructions 
(firmware) permanently. ROM retains its content even when the power is off and is mostly read-
only, meaning users cannot easily modify its contents. While RAM is essential for multitasking 
and performance, ROM is crucial for system booting. 
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a) ਪ�ਾਇਮਰੀ ਅਤੇ ਸਕ�ਡਰੀ ਮੈਮੋਰੀ ਿਵੱਚ ਅੰਤਰ: ਪ�ਾਇਮਰੀ ਮੈਮੋਰੀ ਉਹ ਮੈਮੋਰੀ ਹੁੰ ਦੀ ਹ ੈਜੋ CPU ਦੁਆਰਾ ਿਸੱਧੀ ਤੌਰ 'ਤ ੇ

ਪਹੁੰ ਚਯੋਗ ਹੁੰ ਦੀ ਹ,ੈ ਿਜਵ� ਿਕ RAM (ਰ�ਡਮ ਐਕਸਸੈ ਮੈਮੋਰੀ) ਅਤ ੇROM (ਰੀਡ ਓਨਲੀ ਮੈਮੋਰੀ)। ਇਹ ਤੇਜ਼ ਹੁੰ ਦੀ ਹ,ੈ ਆਰਜ਼ੀ 

ਤੌਰ 'ਤੇ ਡਟੇਾ ਸੰਭਾਲਦੀ ਹ ੈਅਤ ੇROM ਤ� ਇਲਾਵਾ ਇਹ ਵੋਲੈਟਾਈਲ ਹੁੰ ਦੀ ਹ।ੈ ਦੂਜ ੇਪਾਸ,ੇ ਸਕ�ਡਰੀ ਮੈਮੋਰੀ ਲੰਬ ੇਸਮ� ਲਈ ਡੇਟਾ 

ਸੰਭਾਲਣ ਲਈ ਵਰਤੀ ਜ�ਦੀ ਹ,ੈ ਿਜਸ ਿਵੱਚ ਹਾਰਡ ਡਰਾਈਵ, SSD, CD ਅਤ ੇUSB ਿਡਵਾਈਸ� ਆ�ਦੀਆ ਂਹਨ। ਇਹ ਨੌਨ-

ਵੋਲੈਟਾਈਲ ਹੁੰ ਦੀ ਹ,ੈ ਪ�ਾਇਮਰੀ ਮੈਮੋਰੀ ਨਾਲ�  ਹੌਲੀ ਹੁੰ ਦੀ ਹੈ ਪਰ ਕੰਿਪਊਟਰ ਬੰਦ ਹੋਣ 'ਤੇ ਵੀ ਡੇਟਾ ਸੰਭਾਲੀ ਰੱਖਦੀ ਹ।ੈ 

ਪ�ਾਇਮਰੀ ਮੈਮੋਰੀ ਦੀ ਸੈਮਤਾ ਸੀਿਮਤ ਹੁੰ ਦੀ ਹ,ੈ ਜਦਿਕ ਸਕ�ਡਰੀ ਮਮੋੈਰੀ ਵੱਧ ਸਟੋਰੇਜ ਦੀ ਪ©ੇਕ© ਕਰਦੀ ਹ।ੈ 

b) ROM ਅਤੇ RAM ਿਵੱਚ ਅੰਤਰ: RAM (ਰ�ਡਮ ਐਕਸਸੈ ਮੈਮੋਰੀ) ਇੱਕ ਪ�ਾਇਮਰੀ ਮੈਮੋਰੀ ਹ ੈਜੋ ਵੋਲੈਟਾਈਲ ਹੁੰ ਦੀ ਹ ੈਅਤ ੇ

ਕੰਿਪਊਟਰ ਚੱਲ ਰਹ ੇਸਮ� ਦੌਰਾਨ ਆਰਜ਼ੀ ਤੌਰ 'ਤੇ ਡੇਟਾ ਸੰਭਾਲਦੀ ਹ।ੈ ਇਹ ਐਕਿਟਵ ਪ�ੋਸੈਸ ਅਤ ੇਪ�ੋਗਰਾਮ ਚਲਾਉਣ ਲਈ 

ਵਰਤੀ ਜ�ਦੀ ਹ।ੈ ਕੰਿਪਊਟਰ ਬੰਦ ਹੋਣ 'ਤੇ RAM ਿਵੱਚ ਮੌਜੂਦ ਡੇਟਾ ਿਮਟ ਜ�ਦਾ ਹ।ੈ ROM (ਰੀਡ ਓਨਲੀ ਮੈਮੋਰੀ) ਨੌਨ-

ਵੋਲੈਟਾਈਲ ਹੁੰ ਦੀ ਹ ੈਜੋ ਿਸਸਟਮ ਦੀ ©ੁਰੂਆਤ ਲਈ ਲੋੜ�ਦੇ ਿਨਰਦ©ੇ (ਫਰਮਵੇਅਰ) ਨੰੂ ਸਥਾਈ ਤੌਰ 'ਤੇ ਸੰਭਾਲਦੀ ਹ।ੈ ਇਸ ਦੀ 

ਸਮਗਰੀ ਿਸਰਫ਼ ਪੜ�ੀ ਜ�ਦੀ ਹ ੈਅਤੇ ਆਸਾਨੀ ਨਾਲ ਸੋਧੀ ਨਹ� ਜਾ ਸਕਦੀ। ਿਜੱਥ ੇRAM ਮਲਟੀਟਾਸਿਕੰਗ ਅਤ ੇਪ�ਦਰ©ਨ ਲਈ 

ਮਹੱਤਵਪੂਰਨ ਹ,ੈ ਉਥ ੇROM ਿਸਸਟਮ ਬੂਿਟੰਗ ਲਈ ਅਿਹਮ ਭੂਿਮਕਾ ਿਨਭ�ਦੀ ਹ।ੈ 

 
Q. a) Convert (A0B4)16 to (?)2, (?)8, (?)10. (Nov 23) 

b) Explain the printing mechanism of a laser printer. 
Ans. a) Conversion of (A0B4)₁₆ to Binary, Octal, and Decimal: 

To convert (A0B4)₁₆: 
 Binary (₂): Convert each hex digit to 4-bit binary: 

A = 1010, 0 = 0000, B = 1011, 4 = 0100 
So, (A0B4)₁₆ = 1010000010110100₂ 

 Octal (₈): Group binary in 3-bits from right: 
1010000010110100 → 001 010 000 010 110 100 → 1 2 0 2 6 4 
So, (A0B4)₁₆ = 120264₈ 

 Decimal (₁₀): A=10, B=11 
(10×16³) + (0×16²) + (11×16¹) + (4×16⁰) = 40960 + 0 + 176 + 4 = 41140₁₀ 

 
b) Printing Mechanism of a Laser Printer: A laser printer works using a laser beam and 
electrostatic charges. A photosensitive drum is charged, and a laser discharges parts of the drum 
to form an image. Toner particles stick to the discharged areas. The drum rolls over paper, 
transferring toner in the image pattern. Finally, the paper passes through heated rollers (fuser), 
which melt the toner, fusing it permanently to the paper, producing sharp, high-speed, and high-
resolution prints. 

b) ਲੇਜ਼ਰ ਿਪ�ੰ ਟਰ ਦੀ ਛਪਾਈ ਪ�ਣਾਲੀ: ਲੇਜ਼ਰ ਿਪ�ੰ ਟਰ ਲੇਜ਼ਰ ਬੀਮ ਅਤ ੇਇਲੈਕਟਰੋਸਟੈਿਟਕ ਚਾਰਜ ਦੀ ਵਰਤ� ਕਰਦਾ ਹ।ੈ 

ਇੱਕ ਫੋਟੋਸ�ਸਿਟਵ ਡਰਮ 'ਤੇ ਚਾਰਜ ਕੀਤਾ ਜ�ਦਾ ਹ,ੈ ਿਫਰ ਲੇਜ਼ਰ ਡਰਮ ਦੇ ਖਾਸ ਿਹੱਿਸਆ ਂ ਨੰੂ ਿਡਸਚਾਰਜ ਕਰਦਾ ਹ ੈ ਿਜੱਥ ੇ

ਿਚੱਤਰ ਬਣਾਉਣਾ ਹੁੰ ਦਾ ਹ।ੈ ਟਨੋਰ ਪਾਊਡਰ ਉਹਨ� ਿਡਸਚਾਰਜ ਿਹੱਿਸਆ ਂਨਾਲ ਿਚਪਕ ਜ�ਦਾ ਹ।ੈ ਡਰਮ ਕਾਗਜ਼ �ਤੇ ਘੁੰ ਮਦਾ ਹ ੈ

ਅਤ ੇ ਿਚੱਤਰ ਦੇ ਪੈਟਰਨ ਅਨੁਸਾਰ ਟੋਨਰ ਕਾਗਜ਼ 'ਤੇ ਲਗ ਜ�ਦਾ ਹ।ੈ ਅਖੀਰ ਿਵੱਚ, ਕਾਗਜ਼ ਗਰਮ ਰੋਲਰ� (ਿਫਊਜ਼ਰ) ਿਵਚ� 

ਲੰਘਦਾ ਹ ੈਜੋ ਟੋਨਰ ਨੰੂ ਿਪਘਲਾਕ ੇਕਾਗਜ਼ ਨਾਲ ਸਥਾਈ ਤੌਰ 'ਤੇ ਜੋੜ ਿਦੰਦ ੇਹਨ। ਇਸ ਤਰੀਕ ੇਨਾਲ ਤਜ਼ੇ, ਵਧੀਆ ਗਣੁਵੱਤਾ ਅਤ ੇ

ਹਾਈ-ਿਰਜੋਲੂ©ਨ ਵਾਲੀਆਂ ਿਪ�ੰ ਟ� ਿਤਆਰ ਹੁੰ ਦੀਆ ਂਹਨ। 

 
Q.  a) What is the role of IT in education? (Nov 23) 

b) Explain input and output devices. 
Ans. a) Role of IT in Education: Information Technology (IT) plays a crucial role in modern 
education by enhancing teaching and learning processes. It provides access to a vast range of 
resources through the internet, enables e-learning platforms, virtual classrooms, and 
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multimedia presentations that make learning interactive and engaging. IT supports distance 
learning, personalized learning experiences, and collaborative projects. It also simplifies 
administrative tasks such as attendance, grading, and curriculum planning, thus improving 
efficiency and communication between educators, students, and parents. 
 
b) Input and Output Devices: Input devices are hardware components used to enter data and 
commands into a computer system. Examples include keyboard, mouse, scanner, and 
microphone. Output devices display or present the processed data to the user, such as monitor, 
printer, and speakers. Together, these devices form the essential user interface of a computer, 
allowing interaction between the user and the system. Input devices capture raw data, while 
output devices produce the results in a human-readable form. 
a) ਿਸੱਿਖਆ ਿਵੱਚ IT ਦੀ ਭੂਿਮਕਾ: ਸੂਚਨਾ ਤਕਨਾਲੋਜੀ (IT) ਆਧਿੁਨਕ ਿਸੱਿਖਆ ਿਵੱਚ ਮਹੱਤਵਪੂਰਨ ਭੂਿਮਕਾ ਿਨਭ�ਦੀ ਹ ੈ

ਿਕ�ਿਕ ਇਹ ਪਾਠਪਾਠਣ ਦੀ ਪ�ਿਕਿਰਆ ਨੰੂ ਪ�ਭਾਵ©ਾਲੀ ਅਤ ੇਆਕਰ©ਕ ਬਣਾ�ਦੀ ਹ।ੈ IT ਇੰਟਰਨă {ਟ ਰਾਹ� ਿਵ©ਾਲ ਸਾਧਨ� 

ਤੱਕ ਪਹੁੰ ਚ ਿਦੰਦੀ ਹ,ੈ ਿਜਸ ਿਵੱਚ ਈ-ਲਰਿਨੰਗ ਪਲੇਟਫਾਰਮ, ਵਰਚਅੁਲ ਕਲਾਸਰੂਮ ਅਤ ੇਮਲਟੀਮੀਡੀਆ ਪ�ਜ਼�ਟੇ©ਨ ©ਾਮਲ 

ਹਨ ਜੋ ਿਸੱਖਣ ਦੀ ਪ�ਿਕਿਰਆ ਨੰੂ ਇੰਟਰਐਕਿਟਵ ਬਣਾ�ਦ ੇਹਨ। ਇਹ ਿਡਸਟ�ਸ ਲਰਿਨੰਗ, ਿਵਅਕਤੀਗਤ ਅਿਧਐਨ ਅਤ ੇ

ਸ�ਝੇਦਾਰੀ ਪ�ੋਜੈਕਟ� ਿਵੱਚ ਮਦਦ ਕਰਦੀ ਹ।ੈ IT ਪ�©ਾਸਨਕ ਕੰਮ� ਿਜਵ� ਿਕ ਹਾਜ਼ਰੀ, ਅੰਕ ਿਦੰਨਾ ਅਤ ੇਪਾਠਯਕ�ਮ ਦੀ ਯੋਜਨਾ 

ਬਣਾਉਣ ਨੰੂ ਆਸਾਨ ਬਣਾ�ਦੀ ਹ,ੈ ਿਜਸ ਨਾਲ ਅਿਧਆਪਕ�, ਿਵਿਦਆਰਥੀਆਂ ਅਤ ੇ ਮਾਿਪਆ ਂ ਦਰਿਮਆਨ ਸੰਚਾਰ ਤ ੇ

ਪ�ਭਾਵ©ੀਲਤਾ ਿਵੱਚ ਸੁਧਾਰ ਆ�ਦਾ ਹ।ੈ 

b) ਇਨਪੁਟ ਅਤ ੇਆਉਟਪੁਟ ਿਡਵਾਈਸ�: ਇਨਪਟੁ ਿਡਵਾਈਸ� ਉਹ ਹਾਰਡਵੇਅਰ ਿਹੱਸ ੇਹਨ ਜੋ ਕੰਿਪਊਟਰ ਿਵੱਚ ਡਟੇਾ ਅਤ ੇ

ਹੁਕਮ ਦਾਖਲ ਕਰਨ ਲਈ ਵਰਤ ੇਜ�ਦੇ ਹਨ। ਉਦਾਹਰਣ ਵਜ� ਕੀਬੋਰਡ, ਮਾਊਸ, ਸਕਨੈਰ ਅਤ ੇਮਾਈਕ�ੋਫਨੋ ਆ�ਦੇ ਹਨ। 

ਆਉਟਪਟੁ ਿਡਵਾਈਸ� ਉਹਨ� ਨਤੀਿਜਆ ਂ ਨੰੂ ਵਰਤ�ਕਾਰ ਤੱਕ ਪਹੁੰ ਚਾ�ਦੀਆ ਂਹਨ ਜੋ ਕੰਿਪਊਟਰ ਦਆੁਰਾ ਪ�ੋਸੈਸ ਕੀਤੇ ਜ�ਦ ੇ

ਹਨ, ਿਜਵ� ਿਕ ਮਾਨੀਟਰ, ਪਿਰੰਟਰ ਅਤ ੇਸਪੀਕਰ। ਇਹ ਦੋਵ� ਿਡਵਾਈਸ� ਿਮਲਕ ੇ ਕੰਿਪਊਟਰ ਦੀ ਮੂਲ ਵਰਤ�ਕਾਰ ਇੰਟਰਫੇਸ 

ਬਣਾ�ਦੀਆ ਂਹਨ ਜੋ ਵਰਤ�ਕਾਰ ਅਤ ੇਕੰਿਪਊਟਰ ਿਵਚਕਾਰ ਸੰਚਾਰ ਨੰੂ ਸੰਭਵ ਬਣਾ�ਦੀਆ ਂਹਨ। ਇਨਪਟੁ ਿਡਵਾਈਸ ਕੱਚਾ ਡੇਟਾ 

ਫੜਦੇ ਹਨ, ਜਦਿਕ ਆਉਟਪਟੁ ਿਡਵਾਈਸ ਪਿਰਣਾਮ� ਨੰੂ ਮਨੱੁਖੀ-ਪੜ�ਨਯੋਗ ਰੂਪ ਿਵੱਚ ਪ©ੇ ਕਰਦ ੇਹਨ। 

 
Q. How do the different functional units of a computer system interact with each other? 
Explain with diagram. What are the different types of memory used in a computer 
system? (Nov 24) 
Ans. The functional units of a computer system include the Input Unit, Memory Unit, Central 
Processing Unit (CPU), and Output Unit. These units interact through a structured flow of data 
and control signals: 

1. Input Unit: Devices like keyboard or mouse send data to the computer. 
2. Memory Unit: Temporarily stores input, instructions, and processed data. It includes 

RAM (primary memory) and cache. 
3. CPU: Acts as the brain of the computer. It has the Control Unit (CU), which directs 

operations, and the Arithmetic Logic Unit (ALU), which performs calculations and logical 
comparisons. 

4. Output Unit: Devices like monitor or printer present the processed data to users. 
Interaction Diagram: 
 
[Input Unit] → [CPU (CU + ALU)] ↔ [Memory Unit] → [Output Unit] 
Types of Memory: 

 Primary Memory: Includes RAM (volatile) and ROM (non-volatile). 
 Secondary Memory: Hard disks, SSDs, used for long-term storage. 
 Cache Memory: Small, fast memory close to CPU for frequently used data. 
 Register Memory: Smallest and fastest memory inside the CPU for immediate 

processing. 
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Each unit plays a vital role in the seamless operation of the computer system, ensuring efficient 
data processing and execution. 
ਕੰਿਪਊਟਰ ਿਸਸਟਮ ਦੀਆਂ ਕਾਰਜਾਤਮਕ ਇਕਾਈਆਂ (Functional Units): ਕੰਿਪਊਟਰ ਿਸਸਟਮ ਵੱਖ-ਵੱਖ ਯੂਿਨਟ� ਤ� 

ਬਿਣਆ ਹੁੰ ਦਾ ਹ ੈਜੋ ਡੇਟਾ ਅਤ ੇਕੰਟਰਲੋ ਿਸਗਨਲ� ਦੀ ਇੱਕ ਢ�ਚਾਬੱਧ ਲਿਹਰ ਰਾਹ� ਇਕ-ਦੂਜ ੇਨਾਲ ਸੰਚਾਰ ਕਰਦੀਆਂ ਹਨ: 

1. ਇਨਪੁਟ ਯੂਿਨਟ (Input Unit): ਕੀਬੋਰਡ, ਮਾਊਸ ਵਰਗੀਆਂ ਿਡਵਾਈਸ� ਰਾਹ� ਡੇਟਾ ਕੰਿਪਊਟਰ ਨੰੂ ਭੇਿਜਆ 

ਜ�ਦਾ ਹ।ੈ 

2. ਮੈਮੋਰੀ ਯੂਿਨਟ (Memory Unit): ਇਨਪਟੁ ਡਟੇਾ, ਹੁਕਮ ਅਤ ੇਪ�ੋਸੈਸ ਕੀਤਾ ਿਗਆ ਡੇਟਾ ਆਰਜ਼ੀ ਤੌਰ 'ਤੇ ਸਟਰੋ 

ਕਰਦੀ ਹ।ੈ ਇਸ ਿਵੱਚ RAM (ਪ�ਾਇਮਰੀ ਮੈਮੋਰੀ) ਅਤ ੇਕ©ੈ ©ਾਮਲ ਹਨ। 

3. ਸ�ਟ�ਲ ਪ�ੋਸੈਿਸੰਗ ਯੂਿਨਟ (CPU): ਇਹ ਕੰਿਪਊਟਰ ਦਾ ਿਦਮਾਗ ਹੁੰ ਦਾ ਹ।ੈ ਇਸ ਿਵੱਚ Control Unit (CU) ਹੁੰ ਦੀ ਹ ੈ

ਜੋ ਸਾਰ ੇਕੰਮ ਿਨਰਦੇਿ©ਤ ਕਰਦੀ ਹ,ੈ ਅਤ ੇArithmetic Logic Unit (ALU) ਹੁੰ ਦੀ ਹ ੈਜੋ ਗਣਨਾਵ� ਅਤ ੇਤਰਿਕਕ 

ਤੁਲਨਾਵ� ਕਰਦੀ ਹ।ੈ 

4. ਆਉਟਪਟੁ ਯੂਿਨਟ (Output Unit): ਮਾਨੀਟਰ ਜ� ਪਿਰੰਟਰ ਵਰਗੀਆਂ ਿਡਵਾਈਸ� ਦਆੁਰਾ ਪ�ਸੈੋਸ ਕੀਤਾ ਿਗਆ 

ਡੇਟਾ ਵਰਤ�ਕਾਰ ਨੰੂ ਿਦਖਾਇਆ ਜ�ਦਾ ਹ।ੈ 

 
ਇਕਾਈਆਂ ਿਵਚਕਾਰ ਇੰਟਰੈਕ©ਨ ਡਾਇਾਗ�ਾਮ: 

[Input Unit] → [CPU (CU + ALU)] ↔ [Memory Unit] → [Output Unit] 
 
ਮੈਮੋਰੀ ਦ ੇਪ�ਕਾਰ: 

 ਪ�ਾਇਮਰੀ ਮੈਮੋਰੀ: RAM (ਵੋਲੈਟਾਈਲ) ਅਤ ੇROM (ਨੌਨ-ਵੋਲੈਟਾਈਲ) ©ਾਮਲ। 

 ਸਕ�ਡਰੀ ਮੈਮੋਰੀ: ਹਾਰਡ ਿਡਸਕ, SSD ਆਿਦ, ਜੋ ਲੰਬ ੇਸਮ� ਲਈ ਡਟੇਾ ਸਟੋਰ ਕਰਦ ੇਹਨ। 

 ਕੈ© ਮੈਮੋਰੀ: CPU ਦੇ ਨĂ ੜੇ ਇਕ ਛੋਟੀ ਤੇ ਤੇਜ਼ ਮੈਮੋਰੀ, ਜੋ ਵਾਰ-ਵਾਰ ਵਰਤ ੇਜਾਣ ਵਾਲੇ ਡਟੇਾ ਨੰੂ ਰੱਖਦੀ ਹ।ੈ 

 ਰਿਜਸਟਰ ਮੈਮੋਰੀ: CPU ਦੇ ਅੰਦਰ ਸਭ ਤ� ਛੋਟੀ ਅਤ ੇਤੇਜ਼ ਮੈਮੋਰੀ, ਜੋ ਤੁਰੰਤ ਪ�ੋਸੈਿਸੰਗ ਲਈ ਵਰਤੀ ਜ�ਦੀ ਹ।ੈ 

 
ਹਰ ਇਕਾਈ ਕੰਿਪਊਟਰ ਦੀ ਪ�ਦਰ©ਨਯੋਗਤਾ ਅਤ ੇਕੰਮਕਾਜ ਿਵੱਚ ਮੁੱ ਖ ਭੂਿਮਕਾ ਿਨਭ�ਦੀ ਹ,ੈ ਜੋ ਤੁਰੰਤ ਅਤ ੇਪ�ਭਾਵ©ਾਲੀ ਡੇਟਾ 

ਪ�ੋਸੈਿਸੰਗ ਯਕੀਨੀ ਬਣਾ�ਦੀ ਹ।ੈ 
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Unit-II: Software and Word Processing 
Short Answer Questions: 
 
Q. Write the use of Compiler and Interpreter. (Nov 22) 
Ans. A compiler translates entire code into machine language at once, while an interpreter 
converts and executes code line-by-line. 
ਕੰਪਾਇਲਰ ਪੂਰ ੇਕੋਡ ਨੰੂ ਇੱਕ ੋਵਾਰੀ ਮਸ਼ੀਨ ਭਾ©ਾ ਿਵੱਚ ਤਰਜਮਾ ਕਰਦਾ ਹ,ੈ ਜਦਿਕ ਇੰਟਰਪ�ੀਟਰ ਕੋਡ ਨੰੂ ਲਾਈਨ-ਬਾਈ-

ਲਾਈਨ ਤਰਜਮਾ ਕਰਕ ੇਤੁਰੰਤ ਚਲਾ�ਦਾ ਹ।ੈ 

 
Q. What is the difference between System and Application software? (Nov 23) 
Ans. System software manages hardware (e.g., OS), whereas application software helps users 
perform specific tasks like word processing. 
ਿਸਸਟਮ ਸਾਫਟਵੇਅਰ ਹਾਰਡਵਅੇਰ ਨੰੂ ਪਰਬੰਿਧਤ ਕਰਦਾ ਹ ੈ (ਿਜਵ� ਿਕ ਓਪਰੇਿਟੰਗ ਿਸਸਟਮ), ਜਦਿਕ ਐਪਲੀਕ©ੇਨ 

ਸਾਫਟਵੇਅਰ ਵਰਤ�ਕਾਰ� ਨੰੂ ਵਰਡ ਪ�ੋਸੈਿਸੰਗ ਵਰਗੇ ਿਵਸ਼©ੇ ਕੰਮ ਕਰਨ ਿਵੱਚ ਮਦਦ ਕਰਦਾ ਹ।ੈ 

 
Q. What is the difference between save and save as? (Nov 23) 
Ans. "Save" updates the existing file, while "Save As" creates a new copy with a different name or 
location. 
"ਸੇਵ" ਮੌਜੂਦਾ ਫਾਈਲ ਨੰੂ ਅਪਡੇਟ ਕਰਦਾ ਹ,ੈ ਜਦਿਕ "ਸੇਵ ਐਜ਼" ਇੱਕ ਨਵ� ਨਕਲ ਵੱਖਰ ੇਨ� ਜ� ਥ� 'ਤੇ ਬਣਾ�ਦਾ ਹ।ੈ 

 
Q. What is Booting Process? (Nov 23) 
Ans. Booting is the startup sequence where the system loads the operating system into memory 
after the computer is powered on. 
ਬੂਿਟੰਗ ਇੱਕ ©ੁਰਆੂਤੀ ਪ�ਿਕਿਰਆ ਹ ੈਿਜਸ ਿਵੱਚ ਕੰਿਪਊਟਰ ਆਨ ਹੋਣ ਤ� ਬਾਅਦ ਓਪਰੇਿਟੰਗ ਿਸਸਟਮ ਨੰੂ ਮੈਮੋਰੀ ਿਵੱਚ ਲੋਡ 

ਕੀਤਾ ਜ�ਦਾ ਹ।ੈ 

 
Q. What is the difference between a compiled language and an interpreted language? (Nov 
24) 
Ans. Compiled languages are converted to machine code before execution; interpreted languages 
run code directly line-by-line at runtime. 
ਕੰਪਾਇਲ ਕੀਤੀਆ ਂਭਾ©ਾਵ� ਨੰੂ ਚਲਾਉਣ ਤ� ਪਿਹਲ� ਮਸ਼ੀਨ ਕਡੋ ਿਵੱਚ ਤਬਦੀਲ ਕੀਤਾ ਜ�ਦਾ ਹ,ੈ ਜਦਿਕ ਇੰਟਰਪ�ੀਟ ਕੀਤੀਆ ਂ

ਭਾ©ਾਵ� ਰਨਟਾਈਮ ਦੌਰਾਨ ਕਡੋ ਨੰੂ ਲਾਈਨ-ਬਾਈ-ਲਾਈਨ ਿਸੱਧਾ ਚਲਾ�ਦੀਆਂ ਹਨ। 

 
Q. Differentiate between a single-user and a multi-user operating system. (Nov 24) 
Ans. A single-user OS allows one user at a time, while a multi-user OS supports multiple users 
simultaneously via separate terminals. 
ਇੱਕ ਿਸੰਗਲ-ਯੂਜ਼ਰ ਓਪਰੇਿਟੰਗ ਿਸਸਟਮ ਇੱਕ ਵੇਲੇ ਿਵੱਚ ਿਸਰਫ਼ ਇੱਕ ਵਰਤ�ਕਾਰ ਨੰੂ ਹੀ ਸਹਾਇਤਾ ਿਦੰਦਾ ਹ,ੈ ਜਦਿਕ ਮਲਟੀ-

ਯੂਜ਼ਰ ਓਪਰੇਿਟੰਗ ਿਸਸਟਮ ਵੱਖ-ਵੱਖ ਟਰਮੀਨਲ� ਰਾਹ� ਕਈ ਵਰਤ�ਕਾਰ� ਨੰੂ ਇਕੱਠĂ  ਸਹਾਇਤਾ ਿਦੰਦਾ ਹ।ੈ 

 
Q. What for find and replace is used in Word? (Nov 23) 
Ans. This feature locates specific words or phrases in a document and allows replacing them 
quickly with desired content. 
ਇਹ ਿਵ©ੇ©ਤਾ ਦਸਤਾਵੇਜ਼ ਿਵੱਚ ਖਾਸ ©ਬਦ� ਜ� ਵਾਕ�©� ਨੰੂ ਲੱਭਣ ਅਤ ੇਉਨ� � ਨੰੂ ਚਾਹੀਦ ੇਸਮਗਰੀ ਨਾਲ ਤੇਜ਼ੀ ਨਾਲ ਬਦਲਣ 

ਦੀ ਸਹਲੂਤ ਿਦੰਦੀ ਹ।ੈ 

 
Q. How do backup and recovery programs work, and why are they important? (Nov 24) 
Ans. They store data copies and help restore lost or corrupted data, ensuring business 
continuity and data protection. 
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ਇਹ ਡੇਟਾ ਦੀਆ ਂਨਕਲ� ਨੰੂ ਸੰਭਾਲਦੀਆ ਂਹਨ ਅਤ ੇਗੁੰ ਮ ਜ� ਖਰਾਬ ਹੋਏ ਡਟੇਾ ਨੰੂ ਬਹਾਲ ਕਰਨ ਿਵੱਚ ਮਦਦ ਕਰਦੀਆ ਂਹਨ, 

ਿਜਸ ਨਾਲ ਵਪਾਰ ਦੀ ਲਗਾਤਾਰਤਾ ਅਤ ੇਡੇਟਾ ਸੁਰੱਿਖਆ ਯਕੀਨੀ ਬਣਾਈ ਜ�ਦੀ ਹ।ੈ 

 
Q. What is control panel?  (Nov 23) 
Ans. The Control Panel in Windows lets users configure hardware, software, user accounts, and 
system settings. 
ਿਵੰਡੋਜ਼ ਿਵੱਚ ਕੰਟਰਲੋ ਪੈਨਲ ਵਰਤ�ਕਾਰ� ਨੰੂ ਹਾਰਡਵੇਅਰ, ਸਾਫਟਵੇਅਰ, ਯੂਜ਼ਰ ਅਕਾ�ਟਸ ਅਤ ੇ ਿਸਸਟਮ ਸੈਿਟੰਗਜ਼ ਨੰੂ 

ਕਨਿਫਗਰ ਕਰਨ ਦੀ ਸਹਲੂਤ ਿਦੰਦਾ ਹ।ੈ 

 
Long Answer Questions: 
 
Q. What is the use of operating system? Explain multi programming and utility programs. 
(Nov 22) 
Ans. An Operating System (OS) is a vital system software that manages computer hardware, 
software resources, and provides common services for computer programs. It acts as an 
intermediary between users and the computer hardware. The primary functions of an OS 
include process management, memory management, file system management, device 
management, and security. It ensures efficient execution of all tasks and provides a user-
friendly interface to interact with the system. 
Multiprogramming is a feature of modern operating systems where multiple programs are 
loaded into memory and executed simultaneously. The CPU switches between programs, giving 
the illusion of parallelism. This improves CPU utilization by reducing idle time. For example, 
while one program is waiting for I/O operations to complete, the CPU can execute another 
program. 
Utility Programs are system software designed to help analyze, configure, optimize, or 
maintain a computer. These include disk cleaners, antivirus software, file compressors, 
backup tools, and system monitors. They enhance the functionality of the operating system 
and assist in performing tasks more efficiently. 
Together, multiprogramming and utility programs help ensure that system resources are used 
efficiently, errors are minimized, and the overall performance and usability of the computer 
system are improved. 
ਓਪਰੇਿਟੰਗ ਿਸਸਟਮ (OS) ਇੱਕ ਅਹੰਕਾਰਪਰੂਨ ਿਸਸਟਮ ਸਾਫਟਵੇਅਰ ਹ ੈ ਜੋ ਕੰਿਪਊਟਰ ਦੇ ਹਾਰਡਵੇਅਰ, ਸਾਫਟਵਅੇਰ 

ਸਰਤੋ� ਦਾ ਪਰਬੰਧ ਕਰਦਾ ਹ ੈਅਤ ੇ ਕੰਿਪਊਟਰ ਪ�ੋਗਰਾਮ� ਲਈ ਆਮ ਸੇਵਾਵ� ਪ�ਦਾਨ ਕਰਦਾ ਹ।ੈ ਇਹ ਵਰਤ�ਕਾਰ� ਅਤ ੇ

ਕੰਿਪਊਟਰ ਹਾਰਡਵੇਅਰ ਦਰਿਮਆਨ ਧਰੀਏ ਵ�ਗ ਕੰਮ ਕਰਦਾ ਹ।ੈ OS ਦੇ ਮੁੱ ਖ ਫੰਕ©ਨ ਿਵੱਚ ਪ�ਿਕਿਰਆ ਪ�ਬੰਧਨ, ਮੈਮੋਰੀ 

ਪ�ਬੰਧਨ, ਫਾਇਲ ਿਸਸਟਮ ਪ�ਬੰਧਨ, ਿਡਵਾਈਸ ਪ�ਬੰਧਨ ਅਤ ੇਸੁਰੱਿਖਆ ©ਾਮਲ ਹਨ। ਇਹ ਸਾਰ ੇਕੰਮ ਪ�ਭਾਵ©ਾਲੀ ਢੰਗ ਨਾਲ 

ਚਲਾ�ਦਾ ਹ ੈਅਤ ੇਿਸਸਟਮ ਨਾਲ ਸੰਵਾਦ ਲਈ ਵਰਤ�ਕਾਰ-ਿਮੱਤਰ ਇੰਟਰਫੇਸ ਪ�ਦਾਨ ਕਰਦਾ ਹ।ੈ 

ਮਲਟੀਪਰਗੋ�ਾਿਮੰਗ ਆਧਿੁਨਕ ਓਪਰਿੇਟੰਗ ਿਸਸਟਮ ਦੀ ਇੱਕ ਿਵ©ੇ©ਤਾ ਹ ੈਿਜਸ ਿਵੱਚ ਕਈ ਪ�ੋਗਰਾਮ ਇਕੱਠĂ  ਮੈਮੋਰੀ ਿਵੱਚ ਲੋਡ 

ਕੀਤੇ ਜ�ਦੇ ਹਨ ਅਤ ੇਇਕੱਠĂ  ਚਲਾਏ ਜ�ਦੇ ਹਨ। CPU ਪ�ੋਗਰਾਮ� ਿਵਚਕਾਰ ਵਾਰੀ-ਵਾਰੀ ਸਿਵੱਚ ਕਰਦਾ ਹ,ੈ ਿਜਸ ਨਾਲ ਸਮ� 

ਬਰਾਬਰੀ ਦੀ ਭ�ਮਣਾ ਪੈਦਾ ਹੁੰ ਦੀ ਹ।ੈ ਇਸ ਨਾਲ CPU ਦੀ ਵਰਤ� ਵੱਧਦੀ ਹ ੈਿਕ�ਿਕ ਬੇਕਾਰ ਸਮ� ਘਟਦਾ ਹ।ੈ ਉਦਾਹਰਨ ਵਜ�, 

ਜਦ� ਇੱਕ ਪ�ੋਗਰਾਮ I/O ਕਾਰਵਾਈਆ ਂਦੇ ਖਤਮ ਹੋਣ ਦੀ ਉਡੀਕ ਕਰ ਿਰਹਾ ਹੁੰ ਦਾ ਹ,ੈ ਤਦ CPU ਦੂਜ ੇਪ�ੋਗਰਾਮ ਨੰੂ ਚਲਾ ਸਕਦਾ 

ਹ।ੈ 

ਯੂਿਟਿਲਟੀ ਪ�ੋਗਰਾਮ ਿਸਸਟਮ ਸਾਫਟਵੇਅਰ ਹੁੰ ਦ ੇਹਨ ਜੋ ਕੰਿਪਊਟਰ ਨੰੂ ਿਵ©ਲੇ©ਣ, ਸੰਰਚਨਾ, ਅਪਟਾਈਮਾਈਜ਼ ਅਤ ੇਸੰਭਾਲਣ 

ਿਵੱਚ ਮਦਦ ਕਰਦ ੇਹਨ। ਇਨ� � ਿਵੱਚ ਿਡਸਕ ਕਲੀਨਰ, ਐਟਂੀਵਾਇਰਸ ਸਾਫਟਵੇਅਰ, ਫਾਇਲ ਕੰਪ�ੈਸਰ, ਬੈਕਅੱਪ ਟੂਲ ਅਤ ੇ

ਿਸਸਟਮ ਮਾਨੀਟਰ ©ਾਮਲ ਹਨ। ਇਹ ਓਪਰੇਿਟੰਗ ਿਸਸਟਮ ਦੀ ਕਾਰਗੁਜ਼ਾਰੀ ਵਧਾ�ਦੇ ਹਨ ਅਤ ੇਕੰਮ ਕਰਨ ਿਵੱਚ ਸਹਾਇਤਾ 

ਕਰਦ ੇਹਨ। 
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ਮਲਟੀਪਰਗੋ�ਾਿਮੰਗ ਅਤ ੇਯੂਿਟਿਲਟੀ ਪ�ੋਗਰਾਮ ਿਮਲ ਕ ੇਯਕੀਨੀ ਬਣਾ�ਦੇ ਹਨ ਿਕ ਿਸਸਟਮ ਸਰਤੋ� ਦੀ ਕ©ੁਲ ਵਰਤ� ਹੋਵੇ, 

ਗਲਤੀਆਂ ਘੱਟ ਹੋਣ ਅਤ ੇਕੰਿਪਊਟਰ ਿਸਸਟਮ ਦੀ ਕੁੱ ਲ ਪ�ਦਰ©ਨ ਅਤ ੇਵਰਤ�ਯੋਗਤਾ ਿਵੱਚ ਸੁਧਾਰ ਆਵੇ। 

 
Q.  a) Write the editing features of text in Word documents. (Nov 22) 

b) How the page setting is performed in Word file? 
Ans. a) Editing Features of Text in Word Documents: Microsoft Word offers various editing 
features to modify text efficiently. These include cut, copy, and paste for moving or duplicating 
content; find and replace to locate specific text and change it throughout the document; undo 
and redo for correcting mistakes; and spell and grammar check for proofreading. Users can 
also change font type, size, style (bold, italic, underline), color, and alignment. Additional 
tools include track changes for collaborative editing and commenting for reviewing 
documents. 
b) Page Setting in Word File: Page settings in Microsoft Word are adjusted through the Page 
Layout or Layout tab. Users can modify the margins, orientation (portrait or landscape), 
paper size (A4, letter, etc.), and columns. The Page Setup dialog box allows for fine-tuning 
these elements. Headers and footers can be added through the Insert tab, and page numbers 
can also be inserted. The line spacing and indentation can be adjusted under the Paragraph 
group. All these settings ensure the document layout meets formatting requirements. 
 
a) ਵੱਡੀ ਫਾਈਲ� ਿਵੱਚ ਟੈਕਸਟ ਨੰੂ ਸੰਪਾਿਦਤ ਕਰਨ ਦ ੇਫੀਚਰ: ਮਾਈਕ�ੋਸਫੌਟ ਵਰਡ ਿਵੱਚ ਟੈਕਸਟ ਨੰੂ ਪ�ਭਾਵ©◌ালী ਢੰਗ 

ਨਾਲ ਸੰਪਾਿਦਤ ਕਰਨ ਲਈ ਕਈ ਫੀਚਰ ਹਨ। ਇਹਨ� ਿਵੱਚ ਕੱਟ ੋ(Cut), ਕਾਪੀ (Copy), ਅਤ ੇਪੇਸਟ (Paste) ©ਾਮਲ ਹਨ ਜੋ 

ਸਮੱਗਰੀ ਨੰੂ ਮੂਵ ਜ� ਡੁਪਲੀਕੇਟ ਕਰਨ ਲਈ ਵਰਤ ੇਜ�ਦੇ ਹਨ। ਖੋਜੋ ਅਤ ੇਬਦਲੋ (Find and Replace) ਫੀਚਰ ਨਾਲ ਿਵ©ੇ© 

ਟੈਕਸਟ ਲੱਭ ਕ ੇਉਹਨੰੂ ਸਾਰ ੇਦਸਤਾਵੇਜ਼ ਿਵੱਚ ਬਦਿਲਆ ਜਾ ਸਕਦਾ ਹ।ੈ ਗਲਤੀਆਂ ਨੰੂ ਠੀਕ ਕਰਨ ਲਈ ਅੰਡ ੂ(Undo) ਅਤ ੇ

ਰੀਡ ੂ(Redo) ਫੀਚਰ ਹਨ। ਸਪਲੈ ਅਤ ੇਗ�ੈਮਰ ਚ{ੈਕ (Spell and Grammar Check) ਨਾਲ ਪÿਫਰੀਿਡੰਗ ਕੀਤੀ ਜਾ ਸਕਦੀ 

ਹ।ੈ ਉਪਭੋਗਤਾ ਫ�ਟ ਦੀ ਿਕਸਮ, ਆਕਾਰ, ਅੰਦਾਜ਼ (ਬੋਲਡ, ਇਟਾਿਲਕ, ਅੰਡਰਲਾਈਨ), ਰੰਗ ਅਤ ੇਸੰਰੇਖਣ (alignment) ਵੀ 

ਬਦਲ ਸਕਦ ੇਹਨ। ਹੋਰ ਸਹਾਇਕ ਟੂਲਜ਼ ਿਵੱਚ ਟ�ੈਕ ਚ�ਿਜਜ਼ (Track Changes) ©ਾਮਲ ਹ ੈ ਜੋ ਸਿਹਯੋਗੀ ਸੰਪਾਦਨ ਲਈ 

ਵਰਤੀ ਜ�ਦੀ ਹ ੈਅਤ ੇਿਟੱਪਣੀਆਂ (Commenting) ਦਸਤਾਵੇਜ਼ ਦੀ ਸਮੀਿਖਆ ਲਈ। 

 
b) ਵਰਡ ਫਾਈਲ ਿਵੱਚ ਪਜੇ ਸੈਿਟੰਗ: ਮਾਈਕ�ੋਸੌਫਟ ਵਰਡ ਿਵੱਚ ਪੇਜ ਸੈਿਟੰਗਜ਼ ਨੰੂ ਪੇਜ ਲੇਆਉਟ ਜ� ਲੇਆਉਟ ਟਬੈ ਰਾਹ� 

ਬਦਿਲਆ ਜ�ਦਾ ਹ।ੈ ਉਪਭੋਗਤਾ ਮਾਰਿਜਨ (Margins), ਿਦਸ਼ਾ (Orientation - portrait ਜ� landscape), ਕਾਗਜ਼ ਦਾ 

ਆਕਾਰ (ਿਜਵ� A4, letter ਆਿਦ), ਅਤ ੇਕਾਲਮ� ਨੰੂ ਸੋਧ ਸਕਦ ੇਹਨ। ਪੇਜ ਸੈਟਅਪ ਡਾਇਲੌਗ ਬਾਕਸ ਇਹਨ� ਤੱਤ� ਨੰੂ ਬਰੀਕੀ 

ਨਾਲ ਬਦਲਣ ਲਈ ਵਰਤੀ ਜ�ਦੀ ਹ।ੈ ਇਨਸਰਟ ਟੈਬ ਰਾਹ� ਹੈਡਰ ਅਤ ੇਫੁੱ ਟਰ ©ਾਮਲ ਕੀਤ ੇਜਾ ਸਕਦ ੇਹਨ ਅਤ ੇਪੇਜ ਨੰਬਰ ਵੀ 

ਜੋੜ ੇਜਾ ਸਕਦ ੇਹਨ। ਲਾਈਨ ਸਪਿੇਸੰਗ ਅਤ ੇਇੰਡ�ਟੇ©ਨ ਨੰੂ ਪੈਰਾਗ�ਾਫ ਗਰੁੱ ਪ ਿਵੱਚ ਬਦਿਲਆ ਜਾ ਸਕਦਾ ਹ।ੈ ਇਹ ਸਾਰੀਆਂ 

ਸੈਿਟੰਗਜ਼ ਦਸਤਾਵੇਜ਼ ਦੇ ਫਾਰਮਿੈਟੰਗ ਮਾਪਦੰਡ� ਨੰੂ ਪੂਰਾ ਕਰਨ ਲਈ ਜਰੂਰੀ ਹੁੰ ਦੀਆ ਂਹਨ। 

 
Q. Write short note on: (Nov 23) 
a) Describe the complete process of Mail Merge.  
b) What is cell reference? Explain its advantages.  
Ans. a) Describe the Complete Process of Mail Merge: Mail Merge is a feature in Microsoft 
Word used to create multiple documents, like letters or labels, personalized for each recipient. 
The process begins by creating a main document (e.g., a letter), then connecting it to a data 
source (e.g., Excel file) containing fields such as names and addresses. Next, merge fields are 
inserted into the document (like «Name», «Address»). After previewing the merged documents, 
you can complete the merge by printing or saving the personalized copies. Mail Merge saves 
time and ensures uniformity in mass communication. 
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b) What is Cell Reference? Explain its Advantages: A cell reference in spreadsheet 
applications like Microsoft Excel identifies a cell's location using column letters and row 
numbers (e.g., A1). It allows users to refer to data from other cells in formulas and functions. 
There are three types: relative, absolute, and mixed references. Advantages include dynamic 
updates—if the referenced cell’s value changes, all dependent formulas update automatically—
and efficient data management, making it easier to apply calculations across rows and 
columns without manually rewriting formulas. This enhances accuracy and saves time in large 
datasets. 
 
a) ਮੈਲ ਮਰਜ ਦੀ ਪੂਰੀ ਪ�ਿਕਿਰਆ ਦਾ ਵਰਣਨ ਕਰੋ: ਮੈਲ ਮਰਜ ਮਾਈਕ�ੋਸੌਫਟ ਵਰਡ ਿਵੱਚ ਇੱਕ ਫੀਚਰ ਹ ੈ ਜੋ ਵੱਖ-ਵੱਖ 

ਦਸਤਾਵੇਜ਼, ਿਜਵ� ਿਚੱਠੀਆ ਂਜ� ਲੇਬਲ, ਹਰ ਪ�ਾਪਤਕਰਤਾ ਲਈ ਿਵਅਕਤੀਗਤ ਬਣਾ�ਦਾ ਹ।ੈ ਇਹ ਪ�ਿਕਿਰਆ ਇੱਕ ਮੁੱ ਖ 

ਦਸਤਾਵੇਜ਼ (ਿਜਵ� ਿਚੱਠੀ) ਬਣਾਉਣ ਨਾਲ ©ੁਰ ੂਹੁੰ ਦੀ ਹ,ੈ ਿਫਰ ਇਸਨੂੰ  ਇੱਕ ਡੇਟਾ ਸੋਰਸ (ਿਜਵ� ਐਕਸਲ ਫਾਇਲ) ਨਾਲ ਜੋਿੜਆ 

ਜ�ਦਾ ਹ ੈਿਜਸ ਿਵੱਚ ਨਾਮ ਅਤ ੇਪਤੇ ਵਰਗੇ ਖੇਤਰ ਹੁੰ ਦੇ ਹਨ। ਇਸਦ ੇਬਾਅਦ, ਮਰਜ ਫੀਲਡਜ਼ (ਿਜਵ� «Name», «Address») 

ਦਸਤਾਵੇਜ਼ ਿਵੱਚ ©ਾਮਲ ਕੀਤੇ ਜ�ਦੇ ਹਨ। ਮਰਜ ਕੀਤੇ ਦਸਤਾਵੇਜ਼� ਨੰੂ ਦੇਖਣ ਤ� ਬਾਅਦ, ਤੁਸ� ਿਪ�ੰ ਟ ਕਰਨ ਜ� ਸੰਭਾਲਣ ਦ ੇ

ਰਾਹ� ਿਵਅਕਤੀਗਤ ਨਕਲ� ਿਤਆਰ ਕਰ ਸਕਦ ੇਹ।ੋ ਮੈਲ ਮਰਜ ਸਮ� ਬਚਾ�ਦਾ ਹ ੈਅਤ ੇਵੱਡੀ ਿਗਣਤੀ ਿਵੱਚ ਸੰਦਰਭਤਾ ਬਣਾਈ 

ਰੱਖਦਾ ਹ।ੈ 

 
b) ਸੈ{ਲ ਰੈਫਰ�ਸ ਕੀ ਹੈ? ਇਸਦੇ ਫਾਇਦੇ ਿਵਆਿਖਆ ਕਰੋ: ਸਪ�ੈ{ਡ©ੀਟ ਐਪਲੀਕ©ੇਨ� ਿਜਵ� ਮਾਈਕ�ਸੌੋਫਟ ਐਕਸਲ ਿਵੱਚ ਸ{ੈਲ 

ਰੈਫਰ�ਸ ਇੱਕ ਸ{ੈਲ ਦੀ ਥ� ਨੰੂ ਕਾਲਮ ਦੇ ਅੱਖਰ ਅਤ ੇਰ ੋਦੇ ਨੰਬਰ (ਿਜਵ� A1) ਨਾਲ ਦਰਸਾ�ਦਾ ਹ।ੈ ਇਹ ਉਪਭੋਗਤਾਵ� ਨੰੂ 

ਫਾਰਮਲੂ� ਅਤ ੇਫੰਕ©ਨ� ਿਵੱਚ ਹੋਰ ਸ{ੈਲ� ਦੇ ਡੇਟਾ ਨੰੂ ਸੰਦਰਿਭਤ ਕਰਨ ਦੀ ਆਿਗਆ ਿਦੰਦਾ ਹ।ੈ ਸ{ੈਲ ਰੈਫਰ�ਸ ਿਤੰਨ ਿਕਸਮ� ਦੀ 

ਹੁੰ ਦੀ ਹ:ੈ ਿਰਲੇਿਟਵ, ਐਬਸੋਿਲਊਟ ਅਤ ੇਿਮਕਸਡ। ਇਸਦ ੇਫਾਇਿਦਆ ਂਿਵੱਚ ਡਾਇਨă ਿਮਕ ਅਪਡੇਟ ©ਾਮਲ ਹਨ—ਜੇ ਸੰਦਰਿਭਤ 

ਸ{ੈਲ ਦਾ ਮੁੱ ਲ ਬਦਲਦਾ ਹ ੈਤ� ਸਾਰ ੇਿਨਰਭਰ ਫਾਰਮਲੇੂ ਆਪਣੇ ਆਪ ਅਪਡੇਟ ਹ ੋਜ�ਦੇ ਹਨ—ਅਤ ੇਪ�ਭਾਵ©◌ালী ਡਟੇਾ ਪ�ਬੰਧਨ, 

ਜੋ ਕਤਾਰ� ਅਤ ੇਕਾਲਮ� ‘ਚ ਗਣਨਾਵ� ਨੰੂ ਿਬਨ� ਹੱਥ� ਦੁਬਾਰਾ ਿਲਖ ੇਲਾਗ ੂਕਰਨਾ ਆਸਾਨ ਬਣਾ�ਦਾ ਹ।ੈ ਇਸ ਨਾਲ ਸਹੀਤਾ 

ਵਧਦੀ ਹ ੈਅਤ ੇਵੱਡੇ ਡੇਟਾਸ{ੈਟ� ਿਵੱਚ ਸਮ� ਬਚਦਾ ਹ।ੈ 

 
Q. How can you use macros to automate tasks in Microsoft Word? What are templates, and 
how are they used in Microsoft Word? (Nov 24) 
Ans. Macros in Microsoft Word are used to automate repetitive tasks, improving efficiency and 
reducing manual errors. A macro is essentially a recorded sequence of commands and actions. 
To create one, users go to the View > Macros > Record Macro option, perform the tasks they 
want automated (like formatting, inserting text, or applying styles), and then stop the recording. 
The macro can then be run whenever needed, either through a button or a keyboard shortcut. 
This is particularly useful for repetitive document formatting or inserting standard content. 
Templates in Word are pre-designed documents that serve as a starting point for new 
documents. They contain preset formatting, styles, and sometimes content, allowing users to 
maintain consistency across documents. For example, business letters, resumes, invoices, and 
reports can be created using templates. Users can access templates by clicking File > New and 
selecting from available templates, or by creating their own and saving them with a .dotx 
extension. Templates save time, enforce branding or formatting standards, and streamline 
document creation. 
Both macros and templates significantly enhance productivity in Word by reducing manual 
work and ensuring document uniformity. 
 
ਮਾਈਕ�ੋਸੌਫਟ ਵਰਡ ਿਵੱਚ ਮੈਕਰਜ਼ੋ ਵਰਤ�ਦੀਆ ਂਹਨ ਤਾਿਕ ਦੁਹਰਾਏ ਜਾਣ ਵਾਲੇ ਕੰਮ� ਨੰੂ ਆਟੋਮਟੇ ਕੀਤਾ ਜਾ ਸਕ,ੇ ਿਜਸ ਨਾਲ 

ਕੰਮ ਦੀ ਪ�ਭਾਵ©ੀਲਤਾ ਵਧਦੀ ਹ ੈਅਤ ੇਮੈਨੂਅਲ ਗਲਤੀਆਂ ਘੱਟ ਹੁੰ ਦੀਆ ਂਹਨ। ਮੈਕਰ ੋਦਰਅਸਲ ਹੁੰ ਦਾ ਹ ੈਕਮ�ਡ� ਅਤ ੇ
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ਕਾਰਵਾਈਆਂ ਦੀ ਇੱਕ ਿਰਕਾਰਡ ਕੀਤੀ ਲੜੀ। ਇਸਨੂੰ  ਬਣਾਉਣ ਲਈ, ਉਪਭੋਗਤਾ View > Macros > Record Macro ‘ਤ ੇ

ਜ�ਦੇ ਹਨ, ਿਫਰ ਉਹ ਕੰਮ ਕਰਦ ੇਹਨ ਜੋ ਆਟੋਮੇਟ ਕਰਨĂ  ਹਨ (ਿਜਵ� ਫਾਰਮਿੈਟੰਗ, ਟੈਕਸਟ ©ਾਮਲ ਕਰਨਾ, ਜ� ਸਟਾਈਲ 

ਲਗਾਉਣਾ), ਅਤ ੇਿਫਰ ਿਰਕਾਰਿਡੰਗ ਰੋਕ ਿਦੰਦ ੇਹਨ। ਮੈਕਰ ੋਨੰੂ ਜਦ� ਵੀ ਲੋੜ ਹਵੋ ੇਚਲਾਇਆ ਜਾ ਸਕਦਾ ਹ,ੈ ਚਾਹ ੇਬਟਨ ਰਾਹ� 

ਜ� ਕੀਬੋਰਡ ©ੌਰਟਕੱਟ ਨਾਲ। ਇਹ ਖਾਸ ਕਰਕ ੇਵਾਰ-ਵਾਰ ਦਸਤਾਵੇਜ਼ ਦੀ ਫਾਰਮਿੈਟੰਗ ਕਰਨ ਜ� ਸਟ�ਡਰਡ ਸਮੱਗਰੀ ©ਾਮਲ 

ਕਰਨ ਲਈ ਬਹਤੁ ਫਾਇਦੇਮੰਦ ਹ।ੈ 

ਵਰਡ ਿਵੱਚ ਟੈਮਪਲੇਟ ਪਿਹਲ� ਤ� ਿਤਆਰ ਕੀਤੇ ਹੋਏ ਦਸਤਾਵੇਜ਼ ਹੁੰ ਦੇ ਹਨ ਜੋ ਨਵ� ਦਸਤਾਵੇਜ਼� ਲਈ ©ੁਰੂਆਤੀ ਿਬੰਦ ੂਵਜ� ਕੰਮ 

ਕਰਦ ੇਹਨ। ਇਹਨ� ਿਵੱਚ ਪਿਹਲ� ਹੀ ਫਾਰਮਿੈਟੰਗ, ਸਟਾਈਲ ਅਤ ੇਕਈ ਵਾਰੀ ਕੁਝ ਸਮੱਗਰੀ ਹੁੰ ਦੀ ਹੈ, ਿਜਸ ਨਾਲ ਦਸਤਾਵੇਜ਼� 

ਿਵੱਚ ਇਕਸਾਰਤਾ ਬਣਾਈ ਰੱਖਣ ਿਵੱਚ ਮਦਦ ਿਮਲਦੀ ਹ।ੈ ਉਦਾਹਰਨ ਵਜ�, ਿਬਜ਼ਨਸ ਿਚੱਠੀਆ,ਂ ਿਰਜ਼ਯੂਮ,ੇ ਇਨਵਇੌਸ� ਅਤ ੇ

ਿਰਪਰੋਟ� ਟੈਮਪਲੇਟ ਦੀ ਵਰਤ� ਨਾਲ ਬਣਾਈਆ ਂਜਾ ਸਕਦੀਆ ਂਹਨ। ਉਪਭੋਗਤਾ ਫਾਇਲ > ਿਨਊ ‘ਤੇ ਕਿਲੱਕ ਕਰਕ ੇਉਪਲਬਧ 

ਟੈਮਪਲੇਟ ਚਣੁ ਸਕਦ ੇਹਨ ਜ� ਆਪਣੇ ਬਣਾਏ ਟੈਮਪਲੇਟ ਨੰੂ .dotx ਐਕਸਟ�©ਨ ਨਾਲ ਸੇਵ ਕਰ ਸਕਦ ੇਹਨ। ਟੈਮਪਲੇਟ ਸਮ� 

ਬਚਾ�ਦੇ ਹਨ, ਬ��ਿਡੰਗ ਜ� ਫਾਰਮੈਿਟੰਗ ਿਮਆਰ� ਨੰੂ ਲਾਗ ੂਕਰਦੇ ਹਨ ਅਤ ੇਦਸਤਾਵੇਜ਼ ਬਣਾਉਣ ਦੀ ਪ�ਿਕਿਰਆ ਨੰੂ ਤੇਜ਼ ਕਰਦ ੇ

ਹਨ। 

ਮੈਕਰਜ਼ੋ ਅਤ ੇਟੈਮਪਲੇਟ ਦੋਹ� ਵਰਡ ਿਵੱਚ ਪ�ੋਡਕਟੀਵਟੀ ਵਧਾ�ਦ ੇਹਨ, ਮੈਨੂਅਲ ਕੰਮ ਘਟਾ�ਦੇ ਹਨ ਅਤ ੇਦਸਤਾਵੇਜ਼� ਿਵੱਚ 

ਇਕਸਾਰਤਾ ਯਕੀਨੀ ਬਣਾ�ਦੇ ਹਨ। 

with anything else! 
 
Q. How do operating systems manage computer resources such as memory, CPU, and 
storage? What is disk management software, and how is it used to manage computer 
storage? (Nov 24) 
Ans. Operating systems (OS) play a vital role in managing computer resources such as memory, 
CPU, and storage efficiently. The OS acts as an intermediary between hardware and software, 
ensuring that each resource is allocated properly to various programs and users. 
Memory management is handled by the OS through processes like paging and segmentation, 
which track every byte in memory and allocate or deallocate space as needed. It ensures that 
multiple applications can run simultaneously without interfering with each other. 
CPU management is done using scheduling algorithms that assign processor time to various 
tasks based on priority, fairness, or efficiency. This allows multitasking and ensures optimal CPU 
utilization. 
Storage management involves organizing, reading, and writing data to storage devices such as 
hard drives or SSDs. The OS manages file systems, access permissions, and directory structures. 
Disk management software is a tool provided by the OS or third parties to manage storage 
devices. It allows users to format drives, partition disks, check for errors, and monitor disk 
health. Examples include Disk Management in Windows or fdisk in Linux. These tools are 
essential for optimizing storage usage, improving system performance, and ensuring data 
integrity. 
 
ਆਪਰਿੇਟੰਗ ਿਸਸਟਮ (OS) ਕੰਿਪਊਟਰ ਦੇ ਸਾਧਨ� ਿਜਵ� ਮੈਮੋਰੀ, CPU ਅਤ ੇਸਟੋਰੇਜ ਨੰੂ ਪ�ਭਾਵ©ਾਲੀ ਢੰਗ ਨਾਲ ਪ�ਬੰਿਧਤ 

ਕਰਨ ਿਵੱਚ ਅਹੰਕਾਰਪਰੂਕ ਭੂਿਮਕਾ ਿਨਭਾ�ਦੇ ਹਨ। OS ਹਾਰਡਵਅੇਰ ਅਤ ੇਸਾਫਟਵੇਅਰ ਿਵਚਕਾਰ ਇੱਕ ਮੱਧਸਥ ਬਣ ਕ ੇਕੰਮ 

ਕਰਦਾ ਹ,ੈ ਇਹ ਯਕੀਨੀ ਬਣਾ�ਦਾ ਹ ੈਿਕ ਹਰ ਸਰਤੋ ਨੰੂ ਵੱਖ-ਵੱਖ ਪ�ਗੋਰਾਮ� ਅਤ ੇਉਪਭੋਗਤਾਵ� ਲਈ ਠੀਕ ਤਰੀਕ ੇਨਾਲ ਵੰਿਡਆ 

ਜਾਵੇ। 

ਮੈਮੋਰੀ ਮੈਨĂ ਜਮ�ਟ OS ਦਆੁਰਾ ਪੇਿਜੰਗ (Paging) ਅਤ ੇਸੈਗਮ�ਟੇ©ਨ (Segmentation) ਵਰਗੀਆ ਂਪ�ਿਕਿਰਆਵ� ਰਾਹ� 

ਕੀਤੀ ਜ�ਦੀ ਹ,ੈ ਜੋ ਮੈਮੋਰੀ ਦੇ ਹਰ ਬਾਈਟ ਨੰੂ ਟਰੈਕ ਕਰਦੀ ਹ ੈਅਤ ੇਜਦ� ਲੋੜ ਹੋਵੇ ਤ� ਥ� ਿਨਰਧਾਿਰਤ ਜ� ਰੱਦ ਕਰਦੀ ਹ।ੈ ਇਹ 

ਯਕੀਨੀ ਬਣਾ�ਦਾ ਹ ੈਿਕ ਕਈ ਐਪਲੀਕ©ੇਨ� ਇੱਕ ੇਸਮ� 'ਚ ਚੱਲ ਸਕਣ ਤੇ ਇੱਕ ਦੂਜ ੇ'ਚ ਦਖਲ ਨਾ ਦਣੇ। 
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CPU ਮੈਨĂ ਜਮ�ਟ ਿਵੱਚ OS ਵੱਲ�  ਸਡੀਊਿਲੰਗ ਐਲਗੋਿਰਦਮ ਵਰਤ ੇਜ�ਦੇ ਹਨ ਜੋ ਵੱਖ-ਵੱਖ ਕੰਮ� ਨੰੂ ਪ�ੋਸੈਸਰ ਸਮ� ਅਵੰਿਟਤ 

ਕਰਦ ੇਹਨ, ਇਹ ਪ�ਾਥਿਮਕਤਾ, ਇਨਸਾਫ ਜ� ਕ©ੁਲਤਾ ਦੇ ਅਧਾਰ 'ਤੇ ਹੁੰ ਦਾ ਹ।ੈ ਇਹ ਮਲਟੀਟਾਸਿਕੰਗ ਦੀ ਆਿਗਆ ਿਦੰਦਾ ਹ ੈ

ਅਤ ੇCPU ਦੀ ਉਤਿਕ�ਸ਼ਟ ਵਰਤ� ਨੰੂ ਯਕੀਨੀ ਬਣਾ�ਦਾ ਹ।ੈ 

ਸਟੋਰੇਜ ਮੈਨĂ ਜਮ�ਟ ਿਵੱਚ ਡਟੇਾ ਨੰੂ ਸਟੋਰੇਜ ਿਡਵਾਈਸ� (ਿਜਵ� ਹਾਰਡ ਿਡਸਕ ਜ� SSD) 'ਚ ਿਲਖਣ, ਪੜ�ਨ ਅਤ ੇ ਿਵਵਸਿਥਤ 

ਕਰਨ ਦੀ ਪ�ਿਕਿਰਆ ©ਾਮਲ ਹੁੰ ਦੀ ਹ।ੈ OS ਫਾਈਲ ਿਸਸਟਮ, ਐਕਸਸੈ ਪਰਮੀ©ਨ ਅਤ ੇਡਾਇਰਕੈਟਰੀ ਢ�ਿਚਆਂ ਦਾ ਪ�ਬੰਧ 

ਕਰਦਾ ਹ।ੈ 

ਿਡਸਕ ਮੈਨĂ ਜਮ�ਟ ਸਾਫਟਵੇਅਰ ਇੱਕ ਐਸਾ ਟਲੂ ਹੁੰ ਦਾ ਹ ੈਜੋ OS ਜ� ਤੀਸਰੀ ਿਧਰ ਵੱਲ�  ਉਪਲੱਬਧ ਕਰਵਾਇਆ ਜ�ਦਾ ਹ,ੈ ਜੋ 

ਸਟੋਰੇਜ ਿਡਵਾਈਸ� ਦਾ ਪ�ਬੰਧ ਕਰਨ ਲਈ ਵਰਿਤਆ ਜ�ਦਾ ਹ।ੈ ਇਹ ਉਪਭੋਗਤਾਵ� ਨੰੂ ਡ�ਾਈਵ� ਨੰੂ ਫਾਰਮਟੈ ਕਰਨ, ਿਡਸਕ ਨੰੂ 

ਭਾਗ� ਿਵੱਚ ਵੰਡਣ, ਗਲਤੀਆਂ ਦੀ ਜ�ਚ ਕਰਨ ਅਤ ੇਿਡਸਕ ਦੀ ਿਸਹਤ ਦੀ ਿਨਗਰਾਨੀ ਕਰਨ ਦੀ ਆਿਗਆ ਿਦੰਦਾ ਹ।ੈ ਉਦਾਹਰਨ 

ਵਜ�, Windows ਿਵੱਚ Disk Management ਜ� Linux ਿਵੱਚ fdisk। ਇਹ ਟੂਲ ਸਟੋਰੇਜ ਦੀ ਵਰਤ� ਨੰੂ ਉਤਿਕ�ਸ਼ਟ 

ਬਣਾਉਣ, ਿਸਸਟਮ ਦੀ ਕਾਰਗੁਜ਼ਾਰੀ ਸੁਧਾਰਨ ਅਤ ੇਡੇਟਾ ਦੀ ਸੁਰੱਿਖਆ ਯਕੀਨੀ ਬਣਾਉਣ ਲਈ ਬਹੁਤ ਜ਼ਰੂਰੀ ਹਨ। 
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Unit-III: Spreadsheets and Presentation 
Short Answer Questions: 
 
Q. What is cell reference in spreadsheet? (Nov 22) 
Ans. A cell reference identifies a specific cell in a spreadsheet using its column letter and row 
number (e.g., A1). It helps in performing calculations and linking data. 
ਸ{ੈਲ ਰੈਫਰ�ਸ ਇੱਕ ਸਪ�ੈਡ©ੀਟ ਿਵੱਚ ਿਕਸ ੇ ਿਨਰਧਾਰਤ ਸ{ੈਲ ਦੀ ਪਿਹਚਾਣ ਕਰਦਾ ਹ ੈ ਜੋ ਕਾਲਮ ਅੱਖਰ ਅਤ ੇਕਤਾਰ ਨੰਬਰ 

(ਉਦਾਹਰਨ ਵਜ�, A1) ਦਆੁਰਾ ਦੱਿਸਆ ਜ�ਦਾ ਹ।ੈ ਇਹ ਗਣਨਾਵ� ਕਰਨ ਅਤ ੇਡੇਟਾ ਨੰੂ ਜੋੜਨ ਿਵੱਚ ਮਦਦ ਕਰਦਾ ਹ।ੈ 

 
Q. What is the purpose of speaker notes in Microsoft PowerPoint? (Nov 24) 
Ans. Speaker notes allow presenters to add reminders or key points for each slide, visible only to 
them during the presentation. 
ਸਪੀਕਰ ਨĄ ਟਸ ਪ�ਜ਼�ਟੇ©ਨ ਦੌਰਾਨ ਹਰ ਸਲਾਈਡ ਲਈ ਪ�ਸਤਾਵਕ ਨੰੂ ਯਾਦ ਿਦਵਾਉਣ ਵਾਲੀਆਂ ਗੱਲ� ਜ� ਮੁੱ ਖ ਿਬੰਦ ੂਿਲਖਣ ਦੀ 

ਸਹਲੂਤ ਿਦੰਦੀਆਂ ਹਨ, ਜੋ ਿਸਰਫ਼ ਉਨ� � ਨੰੂ ਹੀ ਨਜ਼ਰ ਆ�ਦੀਆ ਂਹਨ। 

 
Q. How do you insert images, charts, and other objects into a Microsoft Word document? 
(Nov 24) 
Ans. Use the "Insert" tab to add images, charts, tables, and shapes into a document, enhancing its 
visual appeal and information clarity. 
"ਇਨਸਰਟ" ਟੈਬ ਦੀ ਵਰਤ� ਕਰਕ ੇਦਸਤਾਵੇਜ਼ ਿਵੱਚ ਿਚੱਤਰ, ਚਾਰਟ, ਟੇਬਲ ਅਤ ੇਆਕਾਰ ©ਾਮਲ ਕਰ ੇਜ�ਦੇ ਹਨ, ਿਜਸ ਨਾਲ 

ਇਸ ਦੀ ਿਵਜ਼ੂਅਲ ਆਕਰ©ਣਤਾ ਅਤ ੇਜਾਣਕਾਰੀ ਦੀ ਸਪ©ਟਤਾ ਵਧਦੀ ਹ।ੈ 

 
Q. How can you sort the data in Microsoft Excel? (Nov 24) 
Ans. Excel allows you to sort data alphabetically, numerically, or by custom order using the 
“Sort” feature under the “Data” tab. 
Excel ਿਵੱਚ ਤੁਸ� “ਡੇਟਾ” ਟਬੈ ਹੇਠ� ਆਉਣ ਵਾਲੀ “ਸੋਰਟ” ਿਵ©ੇ©ਤਾ ਦੀ ਵਰਤ� ਕਰਕ ੇਡੇਟਾ ਨੰੂ ਅੱਖਰ� ਅਨੁਸਾਰ, ਅੰਕ� 

ਅਨੁਸਾਰ ਜ� ਕਸਟਮ ਕ�ਮ ਿਵੱਚ ਲਗਾਤਾਰ ਕਰ ਸਕਦ ੇਹ।ੋ 

 
 
Long Answer Questions: 
 
Q. What is need for animation? How the formatting is done on slide shows? (Nov 22) 
Ans. Animation in presentations serves as a powerful visual tool to enhance understanding and 
engagement. It helps in: 

 Grabbing audience attention by adding movement and interest to content. 
 Controlling information flow by revealing bullet points or graphics step-by-step, 

ensuring that the audience focuses on one idea at a time. 
 Demonstrating concepts such as processes, flows, or changes over time. 
 Emphasizing key points through motion, color, or effect to reinforce the message. 

It is especially useful in educational, marketing, and business presentations where visual appeal 
and clarity are crucial. 
 
Formatting on Slide Shows: 
Formatting slide shows in presentation tools like Microsoft PowerPoint includes: 

1. Applying Slide Layouts: Choose predefined layouts (e.g., title, content, comparison) for 
consistency. 

2. Inserting Transitions: Add effects between slides using the Transitions tab to create 
smooth visual movement. 

3. Using Animations: Apply entrance, emphasis, or exit effects to text, images, or charts 
from the Animations tab. 

4. Setting Timing: Control duration, delay, and sequence of animations. 
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5. Slide Design: Use themes, background colors, fonts, and alignments to create a visually 
appealing presentation. 

6. Slide Show Settings: Configure the presentation mode, narration, and timing under the 
Slide Show tab. 

 
ਪ�ਜ਼�ਟ©ੇਨ ਿਵੱਚ ਐਨੀਮੇ©ਨ: ਪ�ਜ਼�ਟੇ©ਨ ਿਵੱਚ ਐਨੀਮ©ੇਨ ਇੱਕ ©ਕਤੀ©ਾਲੀ ਿਵਜ਼ੂਅਲ ਟੂਲ ਵਜ� ਕੰਮ ਕਰਦੀ ਹ ੈਜੋ ਸਮਝ ਅਤੇ 

ਿਦਲਚਸਪੀ ਨੰੂ ਵਧਾ�ਦੀ ਹ।ੈ ਇਹ ਹੇਠ ਿਲਖ ੇਤਰੀਿਕਆ ਂਨਾਲ ਮਦਦਗਾਰ ਸਾਬਤ ਹੁੰ ਦੀ ਹ:ੈ 

• ਸਮੱਗਰੀ ਿਵੱਚ ਗਤੀ ਅਤ ੇਰੁਚੀ ©ਾਮਲ ਕਰਕ ੇਦਰ©ਕ� ਦਾ ਿਧਆਨ ਿਖੱਚਣ ਿਵੱਚ। 
• ਜਾਣਕਾਰੀ ਨੰੂ ਹੌਲੀ-ਹੌਲੀ ਿਵਖਾ ਕ ੇ(ਿਜਵ� ਬੁਲੇਟ ਪੋਇੰਟ ਜ� ਗ�ਾਿਫਕ), ਇਕ ਸਮ� ਇਕ ਿਵਚਾਰ 'ਤੇ ਿਧਆਨ ਕ�ਦਰਤ ਕਰਵਾਉਣ 

ਿਵੱਚ। 

• ਪ�ਿਕਿਰਆਵ�, ਪ�ਵਾਹ� ਜ� ਸਮ� ਦੇ ਨਾਲ ਹੋਣ ਵਾਲੇ ਬਦਲਾਅ ਨੰੂ ਦਰਸਾਉਣ ਿਵੱਚ। 

• ਚਲਣ, ਰੰਗ ਜ� ਪ�ਭਾਵ ਰਾਹ� ਮਹੱਤਵਪੂਰਨ ਿਬੰਦਆਂੂ ਨੰੂ ਉਜਾਗਰ ਕਰਕ ੇਸੰਦ©ੇ ਨੰੂ ਮਜ਼ਬੂਤ ਬਣਾਉਣ ਿਵੱਚ। 
ਇਹ ਿਵਿਦਆਕ, ਮਾਰਕੀਿਟੰਗ ਅਤ ੇਕਾਰੋਬਾਰੀ ਪ�ਜ਼�ਟੇ©ਨ� ਿਵੱਚ ਖਾਸ ਤੌਰ 'ਤੇ ਲਾਭਕਾਰੀ ਹੁੰ ਦੀ ਹ ੈਿਜੱਥ ੇਿਵਜ਼ੂਅਲ ਆਕਰ©ਣ 

ਅਤ ੇਸਪ©ਟਤਾ ਅਹੰਕਾਰਪਰੂਕ ਹੁੰ ਦੇ ਹਨ। 

 
ਸਲਾਈਡ ©ੋਜ਼ ਦੀ ਫਾਰਮੈਿਟੰਗ: ਮਾਈਕ�ੋਸੌਫਟ ਪਾਵਰਪਇੰੋਟ ਵਰਗੀਆ ਂਪ�ਜ਼�ਟੇ©ਨ ਟੂਲ ਿਵੱਚ ਸਲਾਈਡ ©ੋਜ਼ ਦੀ ਫਾਰਮਿੈਟੰਗ 

ਿਵੱਚ ਹੇਠ ਿਲਖੀਆਂ ਚੀਜ਼� ©ਾਮਲ ਹੁੰ ਦੀਆ ਂਹਨ: 

1. ਸਲਾਈਡ ਲੇਆਉਟ ਲਾਗੂ ਕਰਨਾ: ਿਨਰਧਾਰਤ ਲੇਆਉਟ (ਿਜਵ� ਟਾਈਟਲ, ਸਮੱਗਰੀ, ਤੁਲਨਾ ਆਿਦ) ਚਣੁ ਕ ੇ

ਇੱਕਸਾਰਤਾ ਬਣਾਈ ਰੱਖਣੀ। 

2. ਟ��ਜ਼ੀ©ਨ ©ਾਮਲ ਕਰਨਾ: ਸਲਾਈਡ� ਦਰਿਮਆਨ ਪ�ਭਾਵ ਜੋੜਣ ਲਈ Transitions ਟੈਬ ਦੀ ਵਰਤ� ਕਰਨਾ। 

3. ਐਨੀਮੇ©ਨ ਵਰਤਣਾ: ਟੈਕਸਟ, ਿਚੱਤਰ ਜ� ਚਾਰਟ ਲਈ entrance, emphasis ਜ� exit effects ਲਗਾਉਣ ਲਈ 

Animations ਟੈਬ ਦੀ ਵਰਤ� ਕਰਨਾ। 

4. ਟਾਈਿਮੰਗ ਸੈਟ ਕਰਨਾ: ਐਨੀਮ©ੇਨ� ਦੀ ਿਮਆਦ, ਡੀਲੇਅ ਅਤ ੇਕ�ਮ ਨੰੂ ਿਨਯੰਿਤ�ਤ ਕਰਨਾ। 

5. ਸਲਾਈਡ ਿਡਜ਼ਾਈਨ: ਥੀਮ�, ਬਕੈਗ�ਾ�ਡ ਰੰਗ, ਫ�ਟ ਅਤ ੇਅਲਾਈਨਮ�ਟ ਦੀ ਵਰਤ� ਕਰਕ ੇ ਿਵਜ਼ਅੂਲੀ ਰੂਪ ਿਵੱਚ 

ਆਕਰ©ਕ ਪ�ਜ਼�ਟੇ©ਨ ਿਤਆਰ ਕਰਨੀ। 

6. ਸਲਾਈਡ ©ੋ ਸੈਿਟੰਗ: Slide Show ਟਬੈ ਹੇਠ ਪ�ਸਤੁਤੀ ਮੋਡ, ਨă ਰ©ੇਨ ਅਤ ੇਟਾਈਿਮੰਗ ਆਿਦ ਸੰਰਚਨਾ ਕਰਨੀ। 

 
Q. What are the different types of charts in MS-Excel? And write steps to insert chart in 
Excel Sheet. (Nov 23) 
Ans. Microsoft Excel provides a wide variety of charts that help represent data visually. Common 
types include: 

1. Column Chart – Displays data as vertical bars; useful for comparing values. 
2. Bar Chart – Displays horizontal bars; best for long category names. 
3. Line Chart – Shows trends over time by connecting data points with a line. 
4. Pie Chart – Represents data as slices of a circle to show proportions. 
5. Area Chart – Similar to line chart but filled with color; shows cumulative values. 
6. Scatter Plot (XY Chart) – Shows the relationship between two variables. 
7. Combo Chart – Combines two chart types to display different data series. 
8. Doughnut Chart – Similar to pie chart but with a blank center. 
9. Histogram – Displays frequency distribution. 
10. Bubble Chart – Like scatter plot with a third variable represented by bubble size. 

 
Steps to Insert a Chart in Excel: 

1. Select the data range including headings. 
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2. Go to the Insert tab on the Ribbon. 
3. Click on the Chart type you want (e.g., Column, Line, Pie). 
4. Choose a specific chart style from the dropdown options. 
5. The chart will be inserted into the sheet. You can then format it using the Chart Tools. 

Microsoft Excel ਕਈ ਤਰ�� ਦ ੇਚਾਰਟ ਪ�ਦਾਨ ਕਰਦਾ ਹ ੈਜੋ ਡਾਟਾ ਨੰੂ ਿਵਜ਼ੂਅਲ ਤਰੀਕ ੇਨਾਲ ਦਰਸਾਉਣ ਿਵੱਚ ਮਦਦ ਕਰਦ ੇ

ਹਨ। ਆਮ ਚਾਰਟ ਿਕਸਮ� ਿਵੱਚ ©ਾਮਲ ਹਨ: 

1. ਕਾਲਮ ਚਾਰਟ (Column Chart) – ਡਾਟਾ ਨੰੂ ਲੰਬਵਰ ਸੱਟੀਆ ਂਵਜ� ਦਰਸਾ�ਦਾ ਹ;ੈ ਮੁੱ ਲ� ਦੀ ਤੁਲਨਾ ਕਰਨ ਲਈ 

ਉਪਯੋਗੀ। 

2. ਬਾਰ ਚਾਰਟ (Bar Chart) – ਹੋਰੀਜ�ਟਲ ਸੱਟੀਆ ਂਿਦਖਾ�ਦਾ ਹ;ੈ ਲੰਬ ੇ©�ੇਣੀ ਨਾਮ� ਲਈ ਚੰਗਾ। 

3. ਲਾਈਨ ਚਾਰਟ (Line Chart) – ਡਾਟਾ ਪੁਆਇੰਟਸ ਨੰੂ ਲਾਈਨ ਨਾਲ ਜੋੜ ਕ ੇਸਮ� ਦੇ ਨਾਲ ਰੁਝਾਨ ਦਰਸਾ�ਦਾ ਹ।ੈ 

4. ਪਾਈ ਚਾਰਟ (Pie Chart) – ਡਾਟਾ ਨੰੂ ਗੋਲ ਰੂਪ ਿਵੱਚ ਿਹੱਿਸਆ ਂਵਜ� ਦਰਸਾ�ਦਾ ਹ;ੈ ਅਨੁਪਾਤ ਿਦਖਾਉਣ ਲਈ। 

5. ਏਰੀਆ ਚਾਰਟ (Area Chart) – ਲਾਈਨ ਚਾਰਟ ਵਰਗਾ ਹੀ ਹੁੰ ਦਾ ਹ ੈਪਰ ਰੰਗ ਨਾਲ ਭਿਰਆ ਹਇੋਆ; ਕੁੱਲ ਮੁੱਲ 

ਿਦਖਾ�ਦਾ ਹ।ੈ 

6. ਸਕੈਟਰ ਪਲਾਟ (Scatter Plot / XY Chart) – ਦੋ ਚਲ�ਤਰ� (variables) ਿਵਚਕਾਰ ਸੰਬੰਧ ਿਦਖਾ�ਦਾ ਹ।ੈ 

7. ਕੰਬੋ ਚਾਰਟ (Combo Chart) – ਦੋ ਚਾਰਟ ਿਕਸਮ� ਨੰੂ ਜੋੜ ਕ ੇਵੱਖ-ਵੱਖ ਡਾਟਾ ਸੀਰੀਜ਼ ਨੰੂ ਦਰਸਾ�ਦਾ ਹ।ੈ 

8. ਡੋਨਟ ਚਾਰਟ (Doughnut Chart) – ਪਾਈ ਚਾਰਟ ਵਰਗਾ ਪਰ ਿਵਚਕਾਰ ਖਾਲੀ ਿਹੱਸਾ ਹੁੰ ਦਾ ਹ।ੈ 

9. ਿਹਸਟੋਗ�ਾਮ (Histogram) – ਅੰਕਿੜਆ ਂਦੀ ਆਵਿਰਤੀ ਵੰਡ (frequency distribution) ਿਦਖਾ�ਦਾ ਹ।ੈ 

10. ਬਬਲ ਚਾਰਟ (Bubble Chart) – ਸਕੈਟਰ ਚਾਰਟ ਵਰਗਾ ਪਰ ਤੀਸਰਾ ਵੇਰੀਏਬਲ ਬਬਲ ਦੇ ਆਕਾਰ ਰਾਹ� 

ਦਰਸਾਇਆ ਜ�ਦਾ ਹ।ੈ 

 
Excel ਿਵੱਚ ਚਾਰਟ ਇਨਸਰਟ ਕਰਨ ਦ ੇਕਦਮ: 

1. ਡਾਟਾ ਰ�ਜ (ਹ{ੈਿਡੰਗ ਸਮੇਤ) ਚੁਣੋ। 

2. Ribbon ਿਵੱਚ Insert ਟੈਬ 'ਤੇ ਜਾਓ। 

3. ਜੋ ਚਾਰਟ ਿਕਸਮ ਚਾਹੀਦੀ ਹ ੈ(ਿਜਵ� Column, Line, Pie) ਉਸ 'ਤੇ ਕਿਲੱਕ ਕਰ।ੋ 

4. ਡਰੌਪਡਾਊਨ ਤ� ਖਾਸ ਚਾਰਟ ©ੈਲੀ ਚੁਣੋ। 

5. ਚਾਰਟ ©ੀਟ ਿਵੱਚ ਇਨਸਰਟ ਹ ੋਜਾਵੇਗਾ। ਤੁਸ� Chart Tools ਦੀ ਮਦਦ ਨਾਲ ਇਸਨੰੂ ਫਾਰਮਟੈ ਕਰ ਸਕਦ ੇਹ।ੋ 

 
Q. What is conditional formatting, and how is it used to highlight data in Microsoft Excel? 
How do you create and format charts in Microsoft Excel? (Nov 24) 
Ans. Conditional formatting is a feature in Excel used to automatically apply formatting—such as 
colors, icons, or data bars—to cells based on their values or specific conditions. It helps users 
visually identify trends, patterns, and outliers in a dataset. 
For example, you can highlight: 

 Cells above or below a specific value, 
 Duplicates or unique values, 
 Top 10 or bottom 10 items, 
 Cells with certain text. 

How to Apply Conditional Formatting: 
1. Select the range of cells. 
2. Go to the Home tab and click Conditional Formatting. 
3. Choose a rule type (e.g., Highlight Cells Rules, Top/Bottom Rules, Data Bars). 
4. Set the condition and formatting options. 
5. Click OK to apply. 
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Creating and Formatting Charts in Excel: 
Charts visually represent data to make it easier to analyze. Excel supports various chart types 
like column, line, pie, and bar charts. 
Steps to Create and Format a Chart: 

1. Select your data range. 
2. Go to the Insert tab and choose a chart type. 
3. Excel will insert the chart into your sheet. 
4. Click on the chart to access Chart Tools (Design and Format tabs) to modify titles, 

colors, styles, axis labels, and legends. 
 
ਕੰਡੀ©ਨਲ ਫਾਰਮੈਿਟੰਗ (Conditional Formatting): ਕੰਡੀ©ਨਲ ਫਾਰਮਿੈਟੰਗ Excel ਿਵੱਚ ਇੱਕ ਿਵ©ੇ©ਤਾ ਹ ੈਜੋ ਸ{ੈਲ 

ਦੇ ਮੁੱ ਲ ਜ� ਿਨਰਧਾਰਤ ©ਰਤ� ਦੇ ਅਧਾਰ 'ਤੇ ਆਪਣੇ ਆਪ ਫਾਰਮਿੈਟੰਗ (ਿਜਵ� ਰੰਗ, ਆਈਕਨ ਜ� ਡਾਟਾ ਬਾਰ) ਲਾਗ ੂਕਰਦੀ ਹ।ੈ 

ਇਹ ਵਰਤ�ਕਾਰ� ਨੰੂ ਡਾਟਾ ਸ{ੈਟ ਿਵੱਚ ਰੁਝਾਨ, ਪਟੈਰਨ ਅਤ ੇਅਸਧਾਰਨ ਮੁੱ ਲ (outliers) ਨੰੂ ਿਵਜ਼ੂਅਲ ਤਰੀਕ ੇਨਾਲ ਸਮਝਣ 

ਿਵੱਚ ਮਦਦ ਕਰਦੀ ਹ।ੈ 

ਉਦਾਹਰਨ ਵਜ�, ਤੁਸ� ਹਾਈਲਾਈਟ ਕਰ ਸਕਦ ੇਹੋ: 

• ਿਨਰਧਾਰਤ ਮੁੱ ਲ ਤ� �ਪਰ ਜ� ਹੇਠ� ਵਾਲੇ ਸ{ੈਲ, 

• ਡੁਪਲੀਕੇਟ ਜ� ਿਵਲੱਖਣ ਮੁੱ ਲ, 

• ਟੌਪ 10 ਜ� ਬਾਟਮ 10 ਆਈਟਮ, 

• ਿਕਸ ੇਿਵ©ੇ© ਟੈਕਸਟ ਵਾਲੇ ਸ{ੈਲ। 

ਿਕਵ� ਲਾਗੂ ਕਰੀਏ ਕੰਡੀ©ਨਲ ਫਾਰਮੈਿਟੰਗ: 

1. ਸ{ੈਲ� ਦੀ ਰ�ਜ ਚਣੁ।ੋ 

2. Home ਟੈਬ 'ਤੇ ਜਾਓ ਅਤ ੇConditional Formatting ਤੇ ਕਿਲੱਕ ਕਰ।ੋ 

3. ਇੱਕ ਰੂਲ ਿਕਸਮ ਚਣੁ ੋ(ਿਜਵ� Highlight Cells Rules, Top/Bottom Rules, Data Bars)। 

4. ©ਰਤ ਅਤ ੇਫਾਰਮਿੈਟੰਗ ਿਵਕਲਪ ਸ{ੈਟ ਕਰ।ੋ 

5. OK ਤੇ ਕਿਲੱਕ ਕਰਕ ੇਲਾਗ ੂਕਰ।ੋ 

 
Excel ਿਵੱਚ ਚਾਰਟ ਬਣਾਉਣਾ ਅਤੇ ਫਾਰਮੈਟ ਕਰਨਾ: 

ਚਾਰਟ ਡਾਟਾ ਨੰੂ ਿਵਜ਼ੂਅਲ ਰੂਪ ਿਵੱਚ ਦਰਸਾ�ਦ ੇਹਨ, ਿਜਸ ਨਾਲ ਿਵ©ਲੇ©ਣ ਕਰਨਾ ਆਸਾਨ ਹ ੋਜ�ਦਾ ਹ।ੈ Excel ਕਈ ਿਕਸਮ� 

ਦੇ ਚਾਰਟ ਸਮਰਿਥਤ ਕਰਦਾ ਹ ੈਿਜਵ� ਕਾਲਮ, ਲਾਈਨ, ਪਾਈ, ਅਤ ੇਬਾਰ ਚਾਰਟ। 

ਚਾਰਟ ਬਣਾਉਣ ਅਤੇ ਫਾਰਮੈਟ ਕਰਨ ਦ ੇਕਦਮ: 

1. ਆਪਣੇ ਡਾਟਾ ਦੀ ਰ�ਜ ਚੁਣੋ। 

2. Insert ਟਬੈ 'ਤੇ ਜਾਓ ਅਤ ੇਚਾਹੀਦਾ ਚਾਰਟ ਿਕਸਮ ਚਣੁ।ੋ 

3. Excel ਤੁਹਾਡੀ ©ੀਟ ਿਵੱਚ ਚਾਰਟ ਇਨਸਰਟ ਕਰੇਗਾ। 

4. ਚਾਰਟ 'ਤੇ ਕਿਲੱਕ ਕਰ ੋਤ� ਿਕ Chart Tools (Design ਅਤ ੇFormat ਟਬੈ�) ਖੁਲਣ। ਇਨ� � ਦੀ ਮਦਦ ਨਾਲ ਤੁਸ� 

ਟਾਈਟਲ, ਰੰਗ, ਸਟਾਈਲ, ਐਕਿਸਸ ਲੇਬਲ ਅਤ ੇਲੈਜੰਡ ਨੰੂ ਸੋਧ ਸਕਦੇ ਹ।ੋ 

 
Q. What are some common features of Microsoft PowerPoint, such as slide layout, 
animations, and transitions? What is the difference between a slide master and a slide 
layout in Microsoft PowerPoint? (Nov 24) 
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Ans. Microsoft PowerPoint is a powerful presentation tool that allows users to create and deliver 
visual content effectively. Some of its key features include: 

 Slide Layouts: These provide predefined arrangements for text, images, and objects on 
slides. Layouts like title slide, title and content, or two-content help maintain design 
consistency. 

 Animations: These effects allow text or objects to move on a slide. You can animate 
bullet points, images, or charts to enter, exit, or emphasize during the presentation. 

 Transitions: These are visual effects used when moving from one slide to another, such 
as fade, wipe, or push, enhancing flow and engagement. 

 Design Templates: Ready-made themes and color schemes ensure professional-looking 
presentations. 

 Multimedia Integration: PowerPoint supports the insertion of images, videos, audio, 
and charts. 

 Slide Show Tools: Presenter view, notes, and laser pointer features help during live 
presentations. 

Slide Master vs. Slide Layout: 
 Slide Master is the top slide that controls the overall design of the presentation, such as 

font, background, and logo placement. It ensures a consistent design across all slides. 
 Slide Layouts are sub-elements under the Slide Master that define the arrangement of 

content on individual slides. 
 
Microsoft PowerPoint ਇੱਕ ©ਕਤੀ©ਾਲੀ ਪ�ਜ਼�ਟ©ੇਨ ਟੂਲ ਹੈ ਜ ੋ ਉਪਭਗੋਤਾਵ� ਨੰੂ ਿਵਜ਼ੂਅਲ ਸਮੱਗਰੀ ਨੰੂ 

ਪ�ਭਾਵ©ਾਲੀ ਢੰਗ ਨਾਲ ਬਣਾਉਣ ਅਤੇ ਪ©ੇ ਕਰਨ ਦੀ ਆਿਗਆ ਿਦੰਦਾ ਹੈ। ਇਸ ਦੀਆਂ ਕੁਝ ਮੱੁਖ ਿਵ©ੇ©ਤਾਵ� ਹਨ: 

• ਸਲਾਈਡ ਲੇਆਉਟਸ (Slide Layouts): ਇਹ ਟੈਕਸਟ, ਿਚੱਤਰ� ਅਤ ੇਆਬਜਕੈਟ� ਲਈ ਪਿਹਲ� ਤ� ਬਣੇ ਹੋਏ ਲੇਆਉਟ 

ਪ�ਦਾਨ ਕਰਦ ੇਹਨ। ਿਜਵ� ਟਾਈਟਲ ਸਲਾਈਡ, ਟਾਈਟਲ ਅਤ ੇਸਮੱਗਰੀ, ਜ� ਟੂ-ਕੰਟ�ਟ ਲੇਆਉਟ ਜੋ ਿਡਜ਼ਾਈਨ ਦੀ ਇਕਸਾਰਤਾ 

ਬਣਾਈ ਰੱਖਦੇ ਹਨ। 

• ਐਨੀਮੇ©ਨਜ਼ (Animations): ਇਹ ਪ�ਭਾਵ ਟੈਕਸਟ ਜ� ਆਬਜੈਕਟ ਨੰੂ ਸਲਾਈਡ ‘ਤੇ ਿਹਲਣ ਦੀ ਆਿਗਆ ਿਦੰਦ ੇਹਨ। 

ਤੁਸ� ਬੁਲੇਟ ਪੌਇੰਟ, ਿਚੱਤਰ ਜ� ਚਾਰਟ ਨੰੂ ਐਨਟਰ, ਐਗਿਜ਼ਟ ਜ� ਜ਼ੋਰ ਦੇਣ ਲਈ ਐਨੀਮੇਟ ਕਰ ਸਕਦ ੇਹ।ੋ 

• ਟ��ਜ਼ੀ©ਨਜ਼ (Transitions): ਇਹ ਿਦ�©ਟੀ ਪ�ਭਾਵ ਹਨ ਜੋ ਇੱਕ ਸਲਾਈਡ ਤ� ਦੂਜੀ ਸਲਾਈਡ ਵੱਲ ਜਾਣ ਵੇਲੇ ਵਰਤ ੇਜ�ਦ ੇ

ਹਨ, ਿਜਵ� ਫਡੇ, ਵਾਈਪ ਜ� ਪ©ੁ। ਇਹ ਪ�ਜ਼�ਟੇ©ਨ ਦੇ ਪ�ਵਾਹ ਅਤ ੇਿਦਲਚਸਪੀ ਨੰੂ ਵਧਾ�ਦੇ ਹਨ। 

• ਿਡਜ਼ਾਈਨ ਟੈਮਪਲੇਟਸ (Design Templates): ਿਤਆਰ ©ੈਲੀਆ ਂਅਤ ੇ ਰੰਗ ਸਕੀਮ� ਪ�ਫੋ©ੈਨਲ ਿਦਖਾਈ ਦਣੇ ਵਾਲੀ 

ਪ�ਜ਼�ਟੇ©ਨ ਯਕੀਨੀ ਬਣਾ�ਦੀਆ ਂਹਨ। 

• ਮਲਟੀਮੀਡੀਆ ਇੰਟੀਗ�ੇ©ਨ (Multimedia Integration): PowerPoint ਿਚੱਤਰ�, ਵੀਡੀਓ, ਆਡੀਓ ਅਤ ੇਚਾਰਟ 

©ਾਮਲ ਕਰਨ ਦੀ ਸਹਲੂਤ ਿਦੰਦਾ ਹ।ੈ 

• ਸਲਾਈਡ ©ੋ ਟੂਲਜ਼ (Slide Show Tools): Presenter view, ਨĄ ਟਸ, ਅਤ ੇਲੇਜ਼ਰ ਪੌਇੰਟਰ ਵਰਗੀਆਂ ਿਵ©ੇ©ਤਾਵ� 

ਲਾਈਵ ਪ�ਸਤੁਤੀਆ ਂਦੌਰਾਨ ਮਦਦਗਾਰ ਹਨ। 

 
Slide Master vs. Slide Layout (ਸਲਾਈਡ ਮਾਸਟਰ ਅਤੇ ਸਲਾਈਡ ਲੇਆਉਟ ਿਵੱਚ ਅੰਤਰ): 

• Slide Master (ਸਲਾਈਡ ਮਾਸਟਰ): ਇਹ ਸਭ ਤ� �ਪਰੀ ਸਲਾਈਡ ਹੁੰ ਦੀ ਹ ੈ ਜੋ ਪੂਰੀ ਪ�ਜ਼�ਟੇ©ਨ ਦ ੇ ਿਡਜ਼ਾਈਨ ਨੰੂ 

ਿਨਯੰਿਤ�ਤ ਕਰਦੀ ਹ,ੈ ਿਜਵ� ਫ�ਟ, ਬੈਕਗ�ਾ�ਡ ਅਤ ੇਲੋਗੋ ਦੀ ਸਿਥਤੀ। ਇਹ ਸਾਰੀਆਂ ਸਲਾਈਡ� 'ਚ ਇਕਸਾਰਤਾ ਬਣਾਈ ਰੱਖਦੀ 

ਹ।ੈ 

• Slide Layout (ਸਲਾਈਡ ਲੇਆਉਟ): ਇਹ Slide Master ਦੇ ਹੇਠ� ਆ�ਦੇ ਉਪ-ਅੰਗ ਹਨ ਜੋ ਇਨਿਵਜੂਅਲ ਸਲਾਈਡ� 

�ਤੇ ਸਮੱਗਰੀ ਦੀ ਿਵਵਸਥਾ ਿਨਰਧਾਰਤ ਕਰਦ ੇਹਨ। 
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Unit-IV: Digital Technologies 
Short Answer Questions: 
 
Q. Define Certification Authority. (Nov 22) 
Ans. A Certification Authority (CA) is an entity that issues digital certificates to verify the 
authenticity of websites, individuals, or organizations in secure communications. 
ਸਰਟੀਿਫਕ©ੇਨ ਅਥਾਰਟੀ (CA) ਇੱਕ ਅਿਜਹੀ ਸੰਸਥਾ ਹੁੰ ਦੀ ਹ ੈਜੋ ਿਡਜੀਟਲ ਸਰਟੀਿਫਕਟੇ ਜਾਰੀ ਕਰਦੀ ਹ,ੈ ਤ� ਜੋ ਸੁਰੱਿਖਅਤ 

ਸੰਚਾਰ ਿਵੱਚ ਵ{ੈਬਸਾਈਟ�, ਿਵਅਕਤੀਆਂ ਜ� ਸੰਗਠਨ� ਦੀ ਪ�ਮਾਿਣਕਤਾ ਦੀ ਪ©ੁਟੀ ਕੀਤੀ ਜਾ ਸਕ।ੇ 

 
Q. What is crypto currency? (Nov 22) 
Ans. Cryptocurrency is a decentralized digital currency that uses cryptography for secure 
financial transactions and operates on blockchain technology. 
ਿਕ�ਪਟੋਕਰੰਸੀ ਇੱਕ ਿਵਖੰਿਡਤ ਿਡਜੀਟਲ ਮੁਦਰਾ ਹ ੈਜੋ ਸੁਰੱਿਖਅਤ ਿਵੱਤੀ ਲੈਣ-ਦਣੇ ਲਈ ਿਕ�ਪਟੋਗ�ਾਫੀ ਦੀ ਵਰਤ� ਕਰਦੀ ਹ ੈਅਤ ੇ

ਬਲੌਕਚੇਨ ਤਕਨੀਕ 'ਤੇ ਆਧਾਰਤ ਹੁੰ ਦੀ ਹ।ੈ 

 
Q. Write concept of Mobile Computing. (Nov 22) 
Ans. Mobile computing enables users to access data and perform computing tasks on portable 
devices like smartphones and tablets, regardless of location. 
ਮੋਬਾਈਲ ਕੰਿਪਊਿਟੰਗ ਵਰਤ�ਕਾਰ� ਨੰੂ ਪੋਰਟੇਬਲ ਿਡਵਾਈਸ� ਿਜਵ� ਿਕ ਸਮਾਰਟਫੋਨ ਅਤ ੇਟਬੈਲਟ ਰਾਹ� ਿਕਸ ੇਵੀ ਥ� ਤ� ਡੇਟਾ 

ਤੱਕ ਪਹੁੰ ਚ ਅਤ ੇਕੰਿਪਊਿਟੰਗ ਕੰਮ ਕਰਨ ਦੀ ਸੁਿਵਧਾ ਿਦੰਦੀ ਹ।ੈ 

 
Q. What is UPI (Unified Payments Interface), and how does it facilitate electronic fund 
transfer between bank accounts? (Nov 24) 
Ans. UPI is a real-time payment system in India that allows users to link multiple bank accounts 
and transfer funds instantly using a mobile device. 
UPI ਭਾਰਤ ਿਵੱਚ ਇੱਕ ਰੀਅਲ-ਟਾਈਮ ਭੁਗਤਾਨ ਪ�ਣਾਲੀ ਹ ੈਜੋ ਵਰਤ�ਕਾਰ� ਨੰੂ ਕਈ ਬ�ਕ ਖਾਿਤਆ ਂ ਨੰੂ ਜੋੜਨ ਅਤ ੇਮੋਬਾਈਲ 

ਿਡਵਾਈਸ ਰਾਹ� ਤੁਰੰਤ ਫੰਡ ਟ��ਸਫਰ ਕਰਨ ਦੀ ਸਹਲੂਤ ਿਦੰਦੀ ਹ।ੈ 

 
Long Answer Questions: 
 
Q. Explain the various payment systems available for electronic transaction. (Nov 22) 
Ans. Electronic payment systems are essential for conducting seamless, secure, and efficient 
financial transactions over the internet. These systems have revolutionized the way consumers 
and businesses handle payments, especially in e-commerce. 
1. Credit/Debit Card Payments: This is the most common form of online payment. Users enter 
their card details, which are verified through a payment gateway. Security protocols like OTP 
and CVV enhance safety. 
2. Net Banking: This allows direct payment from a bank account. Users log in to their bank’s 
portal to authorize transactions securely. 
3. Mobile Wallets: Applications like Paytm, Google Pay, and PhonePe store money virtually and 
allow quick transactions through smartphones. They are widely used for both online and offline 
payments. 
4. UPI (Unified Payments Interface): A real-time payment system developed in India, UPI 
allows users to transfer money instantly using a mobile number or UPI ID. It’s known for its 
speed and ease of use. 
5. Electronic Fund Transfer (EFT)/NEFT/RTGS/IMPS: These systems enable interbank 
transfers. IMPS provides real-time services, while NEFT and RTGS work in batches or for large-
value transactions. 
6. Cryptocurrency Payments: Though not mainstream yet, digital currencies like Bitcoin offer 
decentralized and secure transactions. 
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These systems ensure that electronic transactions are fast, reliable, and increasingly secure. 
ਇਲੈਕਟ�ਾਿਨਕ ਭੁਗਤਾਨ ਪ�ਣਾਲੀਆਂ (Electronic Payment Systems) 

ਇਲੈਕਟ�ਾਿਨਕ ਭੁਗਤਾਨ ਪ�ਣਾਲੀਆਂ ਇੰਟਰਨă ਟ ਰਾਹ� ਸੁਰੱਿਖਅਤ, ਤੇਜ਼ ਅਤ ੇਸਚੁਾਰੂ ਿਵੱਤੀ ਲੈਣ-ਦਣੇ ਕਰਨ ਲਈ ਬਹੁਤ ਜ਼ਰੂਰੀ 

ਹਨ। ਇਨ� � ਨĂ  ਖਾਸ ਕਰਕ ੇਈ-ਕਾਮਰਸ ਿਵੱਚ ਗ�ਾਹਕ� ਅਤ ੇਵਪਾਰੀਆ ਂਲਈ ਭੁਗਤਾਨ ਦੇ ਤਰੀਿਕਆ ਂਨੰੂ ਬਦਲ ਕ ੇਰੱਖ ਿਦੱਤਾ ਹ।ੈ 

1. ਕ�ੈਿਡਟ/ਡਿੈਬਟ ਕਾਰਡ ਭੁਗਤਾਨ: ਇਹ ਆਨਲਾਈਨ ਭੁਗਤਾਨ ਦਾ ਸਭ ਤ� ਆਮ ਤਰੀਕਾ ਹ।ੈ ਉਪਭੋਗਤਾ ਆਪਣ ੇ

ਕਾਰਡ ਵੇਰਵੇ ਦਾਖਲ ਕਰਦ ੇਹਨ ਜੋ ਇੱਕ ਪੇਮ�ਟ ਗੇਟਵੇ ਰਾਹ� ਪ�ਮਾਿਣਤ ਕੀਤੇ ਜ�ਦੇ ਹਨ। OTP ਅਤ ੇCVV ਵਰਗੇ 

ਸੁਰੱਿਖਆ ਪ�ੋਟੋਕੋਲ ਸੁਰੱਿਖਆ ਨੰੂ ਵਧਾ�ਦੇ ਹਨ। 

2. ਨă {ਟ ਬ�ਿਕੰਗ (Net Banking): ਇਹ ਬ�ਕ ਖਾਤ ੇਤ� ਿਸੱਧਾ ਭੁਗਤਾਨ ਕਰਨ ਦੀ ਆਿਗਆ ਿਦੰਦਾ ਹ।ੈ ਉਪਭੋਗਤਾ 

ਆਪਣੇ ਬ�ਕ ਦੇ ਪੋਰਟਲ 'ਚ ਲੌਗ ਇਨ ਕਰਕ ੇਸੁਰੱਿਖਅਤ ਢੰਗ ਨਾਲ ਲੈਣ-ਦਣੇ ਨੰੂ ਪ�ਮਾਿਣਤ ਕਰਦ ੇਹਨ। 

3. ਮੋਬਾਈਲ ਵਾਿਲਟ (Mobile Wallets): Paytm, Google Pay, PhonePe ਵਰਗੀਆਂ ਐਪਲੀਕ©ੇਨ� ਪੈਸਾ 

ਵਰਚੁਅਲੀ ਸੰਭਾਲਦੀਆ ਂਹਨ ਅਤ ੇਸਮਾਰਟਫੋਨ ਰਾਹ� ਤੇਜ਼ ਭੁਗਤਾਨ ਦੀ ਆਿਗਆ ਿਦੰਦੀਆਂ ਹਨ। ਇਹ ਆਨਲਾਈਨ 

ਅਤ ੇਆਫਲਾਈਨ ਦੋਹ� ਤਰੀਿਕਆ ਂਨਾਲ ਭੁਗਤਾਨ ਕਰਨ ਲਈ ਵਰਤੀਆਂ ਜ�ਦੀਆ ਂਹਨ। 

4. UPI (ਯੂਿਨਫਾਈਡ ਪਮੇ�ਟਸ ਇੰਟਰਫੇਸ): ਇਹ ਭਾਰਤ ਿਵੱਚ ਿਵਕਿਸਤ ਇੱਕ ਰੀਅਲ-ਟਾਈਮ ਭੁਗਤਾਨ ਪ�ਣਾਲੀ ਹ ੈਜੋ 

ਉਪਭੋਗਤਾਵ� ਨੰੂ ਮੋਬਾਈਲ ਨੰਬਰ ਜ� UPI ID ਰਾਹ� ਤੁਰੰਤ ਪੈਸਾ ਭੇਜਣ ਦੀ ਆਿਗਆ ਿਦੰਦੀ ਹ।ੈ ਇਹ ਤੇਜ਼ੀ ਅਤ ੇ

ਵਰਤਣ ਦੀ ਆਸਾਨੀ ਲਈ ਜਾਣੀ ਜ�ਦੀ ਹ।ੈ 

5. EFT/NEFT/RTGS/IMPS: ਇਹ ਪ�ਣਾਲੀਆਂ ਬ�ਕ� ਦਰਿਮਆਨ ਪੈਸ ੇ ਭੇਜਣ ਲਈ ਵਰਤੀਆਂ ਜ�ਦੀਆ ਂ ਹਨ। 

IMPS ਤੁਰੰਤ ਸੇਵਾਵ� ਿਦੰਦਾ ਹ,ੈ ਜਦਿਕ NEFT ਅਤ ੇRTGS ਬਚੈ� ਿਵੱਚ ਜ� ਵੱਡੀ ਰਕਮ ਦੇ ਲੈਣ-ਦੇਣ ਲਈ ਵਰਤ ੇ

ਜ�ਦੇ ਹਨ। 

6. ਿਕ�ਪਟੋਕਰੰਸੀ ਭੁਗਤਾਨ (Cryptocurrency Payments): ਹਾਲ�ਿਕ ਇਹ ਹੁਣੇ ਤੱਕ ਮੁੱ ਖ ਧਾਰਾ ਨਹ� ਬਣੇ, ਪਰ 

Bitcoin ਵਰਗੀਆ ਂਿਡਜ਼ੀਟਲ ਕਰੰਸੀਆਂ ਕ�ਦਰ-ਰਿਹਤ ਅਤ ੇਸੁਰੱਿਖਅਤ ਲੈਣ-ਦਣੇ ਲਈ ਜਾਣੀਆਂ ਜ�ਦੀਆ ਂਹਨ। 

ਇਹ ਸਾਰੀਆਂ ਭੁਗਤਾਨ ਪ�ਣਾਲੀਆਂ ਇਲੈਕਟ�ਾਿਨਕ ਲੈਣ-ਦੇਣ ਨੰੂ ਤੇਜ਼, ਭਰੋਸੇਯਗੋ ਅਤੇ ਲਗਾਤਾਰ ਿਜ਼ਆਦਾ ਸੁਰੱਿਖਅਤ 

ਬਣਾਉਣ ਿਵੱਚ ਮਦਦ ਕਰਦੀਆਂ ਹਨ। 

  
Q. Discuss Cloud Computing? What is the role of cloud computing in IT applications? (Nov 
22) 
Ans. Cloud computing is a model for delivering computing resources—such as servers, storage, 
databases, networking, software, and analytics—over the internet (“the cloud”) on a pay-as-you-
go basis. It eliminates the need for organizations to invest heavily in physical infrastructure and 
allows them to access computing services on demand, from anywhere. 
There are three main service models in cloud computing: 

1. IaaS (Infrastructure as a Service) – Provides virtualized computing resources over the 
internet. 

2. PaaS (Platform as a Service) – Offers hardware and software tools over the internet for 
application development. 

3. SaaS (Software as a Service) – Delivers software applications over the internet on a 
subscription basis. 

Role in IT Applications: Cloud computing plays a critical role in modern IT by enabling 
flexibility, scalability, and cost-efficiency. It supports remote collaboration, data storage, backup 
solutions, and on-demand software access. Businesses can deploy applications quickly, scale 
infrastructure based on demand, and reduce operational costs. Developers use cloud platforms 
to build, test, and deploy software more efficiently. Moreover, cloud computing supports 
emerging technologies like big data, AI, and IoT by providing the computing power and storage 
they require. 
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Overall, cloud computing has transformed IT operations, enabling businesses to innovate faster 
and be more agile in a digital-first world. 
ਕਲਾਊਡ ਕੰਿਪਊਿਟੰਗ ਇੱਕ ਐਸਾ ਮਾਡਲ ਹ ੈਿਜਸ ਰਾਹ� ਕੰਿਪਊਿਟੰਗ ਸਰਤੋ—ਿਜਵ� ਸਰਵਰ, ਸਟੋਰਜੇ, ਡਾਟਾਬਸੇ, ਨă ਟਵਰਿਕੰਗ, 

ਸਾਫਟਵੇਅਰ ਅਤ ੇਐਨਾਿਲਿਟਕਸ—ਇੰਟਰਨă ਟ ਰਾਹ� ("ਕਲਾਊਡ" ਰਾਹ�) ਪ-ੇਅਜ਼-ਯ-ੂਗੋ (ਭੁਗਤਾਨ ਕਰਕ ੇਵਰਤ)ੋ ਆਧਾਰ 

'ਤੇ ਉਪਲਬਧ ਕਰਵਾਏ ਜ�ਦੇ ਹਨ। ਇਸ ਨਾਲ ਸੰਸਥਾਵ� ਨੰੂ ਭਾਰੀ ਭੌਿਤਕ ਢ�ਚ ੇਿਵੱਚ ਿਨਵੇ© ਕਰਨ ਦੀ ਲੋੜ ਨਹ� ਪ�ਦੀ ਅਤ ੇ

ਉਹ ਿਕਤੇ ਵੀ ਤ� ਆਨ-ਿਡਮ�ਡ ਸਰਿਵਿਸਜ਼ ਤੱਕ ਪਹੁੰ ਚ ਪ�ਾਪਤ ਕਰ ਸਕਦੀਆ ਂਹਨ। 

ਕਲਾਊਡ ਕੰਿਪਊਿਟੰਗ ਦੀਆਂ ਿਤੰਨ ਮੱੁਖ ਸਰਿਵਸ ਮਾਡਲ� ਹਨ: 

1. IaaS (Infrastructure as a Service): ਇੰਟਰਨă ਟ ਰਾਹ� ਵਰਚੁਅਲ ਕੰਿਪਊਿਟੰਗ ਸਰਤੋ (ਿਜਵ� ਸਰਵਰ, 

ਨă ਟਵਰਕ, ਸਟੋਰੇਜ) ਉਪਲਬਧ ਕਰਵਾ�ਦਾ ਹ।ੈ 

2. PaaS (Platform as a Service): ਐਪਲੀਕ©ੇਨ ਿਵਕਾਸ ਲਈ ਹਾਰਡਵੇਅਰ ਅਤ ੇ ਸਾਫਟਵੇਅਰ ਟੂਲਜ਼ 

ਇੰਟਰਨă ਟ ਰਾਹ� ਉਪਲਬਧ ਕਰਵਾ�ਦਾ ਹ।ੈ 

3. SaaS (Software as a Service): ਸਾਫਟਵੇਅਰ ਐਪਲੀਕ©ੇਨ� ਨੰੂ ਸਬਸਿਕ�ਪ©ਨ ਆਧਾਰ 'ਤੇ ਇੰਟਰਨă ਟ 

ਰਾਹ� ਉਪਲਬਧ ਕਰਵਾ�ਦਾ ਹ।ੈ 

 
IT ਐਪਲੀਕ©ੇਨ� ਿਵੱਚ ਭੂਿਮਕਾ: ਕਲਾਊਡ ਕੰਿਪਊਿਟੰਗ ਆਧਿੁਨਕ IT ਿਵੱਚ ਇੱਕ ਮਹੱਤਵਪੂਰਨ ਭੂਿਮਕਾ ਿਨਭਾ�ਦੀ ਹ ੈਿਕ�ਿਕ 

ਇਹ ਲਚਕੀਲੇਪਨ (flexibility), ਸਕੇਲਿਬਿਲਟੀ (scalability) ਅਤ ੇ ਘੱਟ ਲਾਗਤ ਵਾਲੇ ਹੱਲ (cost-efficiency) 

ਮੁਹੱਈਆ ਕਰਦੀ ਹ।ੈ 

 ਇਹ ਦੂਰਵਰਤੀ ਸਿਹਯੋਗ, ਡਾਟਾ ਸਟੋਰੇਜ, ਬੈਕਅੱਪ ਹੱਲ ਅਤ ੇਆਨ-ਿਡਮ�ਡ ਸਾਫਟਵੇਅਰ ਤੱਕ ਪਹੁੰ ਚ ਨੰੂ ਸਹਾਇਕ 

ਬਣਾ�ਦੀ ਹ।ੈ 

 ਵਪਾਰ ਆਪਣੀਆਂ ਐਪਲੀਕ©ੇਨ� ਨੰੂ ਜਲਦੀ ਿਡਪਲੌਇ ਕਰ ਸਕਦ ੇਹਨ, ਮੰਗ ਦੇ ਅਨੁਸਾਰ ਢ�ਚ ੇਨੰੂ ਵਧਾ ਸਕਦ ੇਹਨ 

ਅਤ ੇਓਪਰੇ©ਨਲ ਖਰਚੇ ਘਟਾ ਸਕਦ ੇਹਨ। 

 ਿਡਵੈਲਪਰ ਕਲਾਊਡ ਪਲੇਟਫਾਰਮ� ਰਾਹ� ਐਪਲੀਕ©ੇਨ ਨੰੂ ਤੇਜ਼ੀ ਨਾਲ ਬਣਾ�ਦੇ, ਟੈਸਟ ਕਰਦ ੇਅਤ ੇਿਡਪਲੌਇ ਕਰਦ ੇ

ਹਨ। 

 ਇਹ big data, AI, ਅਤ ੇ IoT ਵਰਗੀਆਂ ਨਵ� ਤਕਨੀਕ� ਲਈ ਲੋੜ�ਦੀ ਕੰਿਪਊਿਟੰਗ ਪਾਵਰ ਅਤ ੇਸਟੋਰੇਜ ਪ�ਦਾਨ 

ਕਰਦਾ ਹ।ੈ 

ਸਾਰਵਭਮੌ ਤੌਰ 'ਤ,ੇ ਕਲਾਊਡ ਕੰਿਪਊਿਟੰਗ ਨĂ  IT ਓਪਰੇ©ਨਜ਼ ਿਵੱਚ ਕ��ਤੀ ਿਲਆਈ ਹ,ੈ ਿਜਸ ਨਾਲ ਵਪਾਰ ਤੇਜ਼ੀ ਨਾਲ 

ਨਵੀਨਤਾ ਿਲਆ ਸਕਦ ੇਹਨ ਅਤ ੇਿਡਜੀਟਲ ਯੁੱ ਗ ਿਵੱਚ ਹੋਰ ਲਚਕੀਲੇ ਬਣੇ ਹਨ। 

 
Q. Explain Electronic Payment and various methods of electronic payment. (Nov 23) 
Ans. Electronic Payment (e-Payment) refers to the process of paying for goods or services 
electronically rather than using cash or paper checks. It allows individuals and businesses to 
perform financial transactions over the internet or electronic networks using digital devices 
such as computers and smartphones. E-payments are widely used in e-commerce, utility bill 
payments, and online banking. 
Various Methods of Electronic Payment: 

1. Credit/Debit Cards: One of the most common e-payment methods, where users make 
payments using card numbers processed through secure gateways. 

2. Net Banking: Direct transfer of funds from a user’s bank account to the merchant via the 
bank’s online portal. 

3. Mobile Wallets (e.g., Paytm, Google Pay): Prepaid digital wallets allow users to load 
money and make payments instantly. 
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4. Unified Payments Interface (UPI): A real-time payment system in India that enables 
instant money transfer between bank accounts using mobile devices. 

5. Electronic Fund Transfer (EFT): Transfer of money from one bank account to another 
electronically, including NEFT and RTGS. 

6. Cryptocurrency: Digital currencies like Bitcoin used for secure and anonymous online 
payments. 

7. Point of Sale (POS) Terminals: Used in physical stores for card-based transactions. 
E-payments enhance convenience, speed, and security, making them essential in today’s digital 
economy 
ਇਲੈਕਟ�ਾਿਨਕ ਭੁਗਤਾਨ ਦਾ ਅਰਥ ਹ ੈਿਕ ਨਕਦ ਜ� ਕਾਗਜ਼ੀ ਚ{ੈਕ ਦੀ ਥ� ਉਤਪਾਦ� ਜ� ਸੇਵਾਵ� ਲਈ ਭੁਗਤਾਨ ਿਡਜ਼ੀਟਲ ਢੰਗ 

ਨਾਲ ਕੀਤਾ ਜਾਵੇ। ਇਹ ਿਵਅਕਤੀਆ ਂਅਤ ੇਵਪਾਰੀਆ ਂ ਨੰੂ ਕੰਿਪਊਟਰ ਜ� ਸਮਾਰਟਫੋਨ ਵਰਗੇ ਿਡਜ਼ੀਟਲ ਿਡਵਾਈਸ� ਰਾਹ� 

ਇੰਟਰਨă {ਟ ਜ� ਹੋਰ ਇਲੈਕਟ�ਾਿਨਕ ਨă ਟਵਰਕ� ਰਾਹ� ਿਵੱਤੀ ਲੈਣ-ਦੇਣ ਕਰਨ ਦੀ ਆਿਗਆ ਿਦੰਦਾ ਹ।ੈ 

e-Payment ਨੰੂ ਈ-ਕਾਮਰਸ, ਿਬਜਲੀ ਦੇ ਿਬੱਲ� ਦੀ ਭੁਗਤਾਨੀ, ਅਤ ੇਆਨਲਾਈਨ ਬ�ਿਕੰਗ ਿਵੱਚ ਿਵਆਪਕ ਤੌਰ 'ਤੇ ਵਰਿਤਆ 

ਜ�ਦਾ ਹ।ੈ 

 
ਇਲੈਕਟ�ਾਿਨਕ ਭੁਗਤਾਨ ਦ ੇਵੱਖ-ਵੱਖ ਤਰੀਕ:ੇ 

1. ਕ�ੈਿਡਟ/ਡਿੈਬਟ ਕਾਰਡ: ਸਭ ਤ� ਆਮ ਤਰੀਿਕਆ ਂ ਿਵੱਚ� ਇੱਕ, ਿਜਸ ਿਵੱਚ ਉਪਭੋਗਤਾ ਆਪਣੇ ਕਾਰਡ ਨੰਬਰ ਰਾਹ� 

ਭੁਗਤਾਨ ਕਰਦੇ ਹਨ ਜੋ ਸੁਰੱਿਖਅਤ ਗੇਟਵੇਜ਼ ਰਾਹ� ਪ�ਿਕਿਰਆ©ੀਲ ਹੁੰ ਦ ੇਹਨ। 

2. ਨă {ਟ ਬ�ਿਕੰਗ (Net Banking): ਉਪਭੋਗਤਾ ਦੇ ਬ�ਕ ਖਾਤ ੇਤ� ਵਪਾਰੀ ਦੇ ਖਾਤ ੇ ਿਵਚ ਪੈਸ ੇਦੀ ਸੀਧੀ ਆਨਲਾਈਨ 

ਟ��ਸਫਰ। 

3. ਮੋਬਾਈਲ ਵਾਿਲਟ (Mobile Wallets): ਿਜਵ� Paytm, Google Pay ਆਿਦ। ਇਹ ਪ�ੀਪੇਡ ਿਡਜ਼ੀਟਲ ਵਾਿਲਟ 

ਹਨ, ਿਜਨ� � ਿਵੱਚ ਪੈਸਾ ਲੋਡ ਕਰਕ ੇਤੁਰੰਤ ਭੁਗਤਾਨ ਕੀਤਾ ਜਾ ਸਕਦਾ ਹ।ੈ 

4. UPI (ਯਿੂਨਫਾਈਡ ਪੇਮ�ਟਸ ਇੰਟਰਫੇਸ): ਭਾਰਤ ਦੀ ਇੱਕ ਰੀਅਲ-ਟਾਈਮ ਭੁਗਤਾਨ ਪ�ਣਾਲੀ ਜੋ ਮੋਬਾਈਲ 

ਿਡਵਾਈਸ ਰਾਹ� ਤੁਰੰਤ ਬ�ਕ ਖਾਿਤਆ ਂਦਰਿਮਆਨ ਟ��ਸਫਰ ਦੀ ਆਿਗਆ ਿਦੰਦੀ ਹ।ੈ 

5. EFT (ਇਲੈਕਟ�ਾਿਨਕ ਫੰਡ ਟ��ਸਫਰ): ਇੱਕ ਬ�ਕ ਖਾਤ ੇਤ� ਦੂਜ ੇਬ�ਕ ਖਾਤ ੇ ਿਵਚ ਪੈਸ ੇਦੀ ਇਲੈਕਟ�ਾਿਨਕ ਟ��ਸਫਰ 

ਪ�ਿਕਿਰਆ, ਿਜਸ ਿਵੱਚ NEFT ਅਤ ੇRTGS ©ਾਮਲ ਹਨ। 

6. ਿਕ�ਪਟੋਕਰੰਸੀ (Cryptocurrency): ਿਜਵ� Bitcoin ਵਰਗੀਆ ਂਿਡਜ਼ੀਟਲ ਮੁਦਰਾਵ� ਜੋ ਗੁਪਤ ਅਤ ੇਸੁਰੱਿਖਅਤ 

ਆਨਲਾਈਨ ਭੁਗਤਾਨ ਲਈ ਵਰਤੀਆ ਂਜ�ਦੀਆ ਂਹਨ। 

7. POS (ਪੌਇੰਟ ਆਫ ਸੇਲ) ਟਰਮੀਨਲ: ਭੌਿਤਕ ਦੁਕਾਨ� ਿਵੱਚ ਕਾਰਡ ਰਾਹ� ਭੁਗਤਾਨ ਲਈ ਵਰਤ ੇਜ�ਦੇ ਿਡਵਾਈਸ। 

 
e-Payment ਦੀਆਂ ਖੂਬੀਆਂ: ਇਹ ਸੁਿਵਧਾਜਨਕ, ਤੇਜ਼ ਅਤ ੇਸਰੱੁਿਖਅਤ ਹਨ, ਜੋ ਆਧਿੁਨਕ ਿਡਜ਼ੀਟਲ ਅਰਥਿਵਵਸਥਾ ਿਵੱਚ 

ਇਨ� � ਨੰੂ ਬੇਹੱਦ ਜ਼ਰੂਰੀ ਬਣਾ�ਦੇ ਹਨ। 

 
Q. How do digital signatures and certification authorities help to ensure the integrity of 
online transactions, and how can they be used to improve security in e-commerce and 
other digital transactions? What is the process to register a digital signature? (Nov 
24),(Nov 24) 
Ans. Digital signatures and certification authorities (CAs) play a critical role in ensuring the 
integrity, authenticity, and security of online transactions, especially in e-commerce and 
digital communication. 
A digital signature is a cryptographic technique that binds a signer’s identity to the data being 
sent. It verifies that the message or document has not been altered during transit and 
authenticates the sender’s identity using public key infrastructure (PKI). It works by 
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generating a hash (a fixed-size string) of the data, which is then encrypted using the sender's 
private key. The recipient uses the sender’s public key to decrypt and verify the hash. 
Certification Authorities (CAs) are trusted third-party entities that issue digital certificates 
to validate the ownership of public keys. These certificates link the identity of the individual or 
organization to their public key, preventing impersonation and fraud. 
Benefits in e-commerce and digital security: 

 Ensures data integrity by detecting tampering. 
 Provides authentication of users or websites. 
 Enables non-repudiation, preventing denial of transactions. 

Process to register a digital signature: 
1. Choose a licensed Certifying Authority (e.g., eMudhra, Sify). 
2. Fill an application form and provide ID proof. 
3. Generate a key pair (public and private). 
4. The CA verifies the details and issues the Digital Signature Certificate (DSC). 

Digital signatures thus enhance trust and secure communication in digital ecosystems. 
ਿਡਜ਼ੀਟਲ ਦਸਤਖਤ ਅਤੇ ਸਰਟੀਿਫਕ©ੇਨ ਅਥਾਰਟੀਜ਼ (CAs) ਆਨਲਾਈਨ ਲੈਣ-ਦੇਣ—ਖਾਸ ਕਰਕ ੇਈ-ਕਾਮਰਸ ਅਤ ੇ

ਿਡਜ਼ੀਟਲ ਸੰਚਾਰ ਿਵੱਚ—ਦੀ ਇਮਾਨਦਾਰੀ, ਪ�ਮਾਿਣਕਤਾ ਅਤੇ ਸੁਰੱਿਖਆ ਨੰੂ ਯਕੀਨੀ ਬਣਾਉਣ ਿਵੱਚ ਅਹੰਕਾਰਪਰੂਕ ਭੂਿਮਕਾ 

ਿਨਭਾ�ਦੇ ਹਨ। 

ਿਡਜ਼ੀਟਲ ਦਸਤਖਤ (Digital Signature): ਇਹ ਇੱਕ ਿਕ�ਪਟਗੋ�ਾਿਫਕ ਤਕਨੀਕ ਹ ੈਜੋ ਭੇਜਣ ਵਾਲੇ ਦੀ ਪਛਾਣ ਨੰੂ ਭੇਜ ੇਗਏ 

ਡਾਟਾ ਨਾਲ ਜੋੜਦੀ ਹ।ੈ ਇਹ ਯਕੀਨੀ ਬਣਾ�ਦਾ ਹ ੈਿਕ ਸੁਨĂ ਹਾ ਜ� ਦਸਤਾਵੇਜ਼ ਭੇਜਣ ਦੌਰਾਨ ਬਦਲੇਆ ਨਹ� ਿਗਆ ਅਤ ੇਭੇਜਣ 

ਵਾਲੇ ਦੀ ਪਛਾਣ ਨੰੂ ਪ�ਮਾਿਣਤ ਕਰਦਾ ਹ।ੈ ਇਹ Public Key Infrastructure (PKI) ਦੇ ਅਧਾਰ 'ਤ ੇਕੰਮ ਕਰਦਾ ਹ:ੈ 

 ਪਿਹਲ� ਡਾਟਾ ਦਾ ਇੱਕ ਹੈ© (ਹਮ©ੈਾ ਇਕ ੋਆਕਾਰ ਦਾ ਕੋਡ) ਬਣਾਇਆ ਜ�ਦਾ ਹ।ੈ 

 ਇਸ ਨੰੂ ਭੇਜਣ ਵਾਲੇ ਦੀ ਪ�ਾਈਵੇਟ ਕੀ ਨਾਲ ਇਨਿਕ�ਪਟ ਕੀਤਾ ਜ�ਦਾ ਹ।ੈ 

 ਪ�ਾਪਤਕਰਤਾ ਭੇਜਣ ਵਾਲੇ ਦੀ ਪਬਿਲਕ ਕੀ ਨਾਲ ਹ©ੈ ਨੰੂ ਿਡਿਕ�ਪਟ ਕਰਦਾ ਹ ੈਅਤ ੇਪ�ਮਾਿਣਤ ਕਰਦਾ ਹ।ੈ 

ਸਰਟੀਿਫਕ©ੇਨ ਅਥਾਰਟੀਜ਼ (CAs): ਇਹ ਭਰੋਸਯੇੋਗ ਤੀਜੀ ਪਾਰਟੀਆ ਂਹੁੰ ਦੀਆ ਂਹਨ ਜੋ ਿਡਜ਼ੀਟਲ ਸਰਟੀਿਫਕੇਟ ਜਾਰੀ 

ਕਰਦੀਆਂ ਹਨ। ਇਹ ਸਰਟੀਿਫਕਟੇ ਿਕਸ ੇਿਵਅਕਤੀ ਜ� ਸੰਸਥਾ ਦੀ ਪਛਾਣ ਨੰੂ ਉਨ� � ਦੀ ਪਬਿਲਕ ਕੀ ਨਾਲ ਜੋੜਦੇ ਹਨ, ਿਜਸ 

ਨਾਲ ਨਕਲੀ ਪਛਾਣ ਅਤ ੇਠੱਗੀ ਤ� ਬਚਾਅ ਹੁੰ ਦਾ ਹ।ੈ 

 
ਈ-ਕਾਮਰਸ ਅਤੇ ਿਡਜ਼ੀਟਲ ਸੁਰੱਿਖਆ ਿਵੱਚ ਲਾਭ: 

• ਡਾਟਾ ਦੀ ਇੰਟੈਿਗ�ਟੀ (ਅਸਲ ਰਪੂ) ਨੰੂ ਯਕੀਨੀ ਬਣਾ�ਦੇ ਹਨ। 

• ਉਪਭੋਗਤਾਵ� ਜ� ਵੈ{ਬਸਾਈਟ� ਦੀ ਪ�ਮਾਿਣਕਤਾ ਪ�ਦਾਨ ਕਰਦ ੇਹਨ। 
• Non-repudiation ਯਕੀਨੀ ਬਣਾ�ਦੇ ਹਨ—ਇਸਦਾ ਅਰਥ ਹ ੈ ਿਕ ਭੇਜਣ ਵਾਲਾ ਲੈਣ-ਦਣੇ ਤ� ਇਨਕਾਰ ਨਹ� ਕਰ 

ਸਕਦਾ। 
 
ਿਡਜ਼ੀਟਲ ਦਸਤਖਤ ਲਈ ਰਿਜਸਟਰੇ©ਨ ਦੀ ਪ�ਿਕਿਰਆ: 

1. ਿਕਸ ੇਲਾਇਸ�ਸ©ੁਦਾ Certifying Authority (ਿਜਵ� eMudhra, Sify) ਦੀ ਚਣੋ ਕਰ।ੋ 

2. ਐਪਲੀਕ©ੇਨ ਫਾਰਮ ਭਰ ੋਅਤ ੇਪਛਾਣ ਸਬਤੂ ਿਦਓ। 

3. Public ਅਤ ੇPrivate Key ਦਾ ਜੋੜ (Key Pair) ਿਤਆਰ ਕਰ।ੋ 

4. CA ਤੁਹਾਡੀ ਜਾਣਕਾਰੀ ਦੀ ਜ�ਚ ਕਰਕ ੇDigital Signature Certificate (DSC) ਜਾਰੀ ਕਰਗੇੀ। 

 
ਨਤੀਜਾ: ਿਡਜ਼ੀਟਲ ਦਸਤਖਤ ਿਡਜ਼ੀਟਲ ਵਾਤਾਵਰਣ ਿਵੱਚ ਭਰੋਸੇਯਗੋ ਅਤੇ ਸੁਰੱਿਖਅਤ ਸੰਚਾਰ ਨੰੂ ਉਤ©ਾਿਹਤ ਕਰਦ ੇਹਨ। 

 


